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Before you begin

This learner guide is based on the unit of competency BSBITU202 Create and use
spreadsheets, Release 1. Your trainer or training organisation must give you information
about this unit of competency as part of your training program. You can access the unit of
competency and assessment requirements at: www.training.gov.au.

How to work through this learner guide

This learner guide contains a number of features that will assist you in your learning. Your
trainer will advise which parts of the learner guide you need to read, and which practice
tasks and learning checkpoints you need to complete. The features of this learner guide are
detailed in the following table.

Feature of the
learner guide

Learning content

Examples and case
studies

Practice tasks

Video clips

Summary

Learning checkpoints

How you can use each feature

Read each topic in this learner guide. If you come across content that
is confusing, make a note and discuss it with your trainer. Your trainer
is in the best position to offer assistance. It is very important that you
take on some of the responsibility for the learning you will undertake.

Examples of completed documents that may be used in a workplace
are included in this learner guide. You can use these examples as
models to help you complete practice tasks and learning checkpoints.

Case studies highlight learning points and provide realistic examples of
workplace situations.

Practice tasks give you the opportunity to put your skills and knowledge
into action. Your trainer will tell you which practice tasks to complete.

Where QR codes appear, learners can use smartphones

. : : : [m] 7% ]
and other devices to access video clips relating to the ;; L
content. For information about how to download a QR FEL* ¥

reader app or accessing video on your device, please visit
our website: www.aspirelr.com.au/help

Key learning points are provided at the end of each topic.

There is a learning checkpoint at the end of each topic. Your trainer will
tell you which learning checkpoints to complete. These checkpoints
give you an opportunity to check your progress and apply the skills and
knowledge you have learnt.
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Foundation skills

As you complete learning using this guide, you will be developing the foundation skills
relevant for this unit. Foundation skills are the language, literacy and numeracy (LLN)
skills and the employability skills required for participation in modern workplaces and

contemporary life.

The following table outlines specific foundation skills noted for your learning in this

learner guide.

Foundation skill area
Reading
Writing

Oral communication

Numeracy
Navigate the world of work
Interact with others

Get the work done

Foundation skill description

Recognises numerical and textual information within a range
of resources to determine and complete work according to
requirements

Enters and amends routine data into software using a format
appropriate to requirements

Listens to short and specific instructions and uses questions
to clarify understanding

Uses simple mathematical language to confirm and convey
requirements

Uses basic mathematical skills to create and apply
spreadsheet formulae

Recognises, understands and adheres to legislative and
organisational requirements in undertaking own work

Recognises purpose of various communications directly
relevant to own role and clarifies as required

Uses key software features and functions in performing
specific work tasks

viii
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Before you begin

What do you already know?

Use the following table to identify what you may already know. This may assist you to work
out what to focus on in your learning.

Topic

Topic 1 Select and prepare

resources

Topic 2 Create simple
spreadsheets

Topic 3 Produce simple
charts

1A

1B

1C

2A

2B

2C

2D

3A

3B

3C

Key outcome

Adjust workspace, furniture
and equipment to suit user
requirements

Minimise wastage

Identify and clarify spreadsheet
task requirements

Enter, check and amend data while
maintaining consistency of design
and layout

Use software functions to format
spreadsheets

Use and test formulas to confirm
output meets task requirements

Overcome problems with
spreadsheet design and production

Select a chart type and design
to enable valid representation of
numerical data

Create charts

Use formatting features to modify
the chart type and layout

Rate your confidence
in each section

U Confident
U Basic understanding
U Not confident

1 confident
(] Basic understanding
L Not confident

U Confident
U Basic understanding
U Not confident

U Confident
U Basic understanding
U Not confident

U Confident
U Basic understanding
U Not confident

U Confident
U Basic understanding
1 Not confident

1 Confident
] Basic understanding
1 Not confident

U Confident
U Basic understanding
U Not confident

1 confident
(] Basic understanding
L Not confident

U Confident
U Basic understanding
U Not confident
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Topic 4 Finalise 4A  Preview, adjust and print 4 confident
spreadsheets spreadsheets and accompanying

U Basic understanding
charts

U Not confident

4B Ensure data input meets time lines [ Confident
and requirements for speed and

U Basic understanding
accuracy

U Not confident

4C Name and store a spreadsheet, and [ Confident

exit an application safely O Basic understanding

U Not confident
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Topic 1
Select and prepare resources

Organisations use spreadsheets to store and calculate numerical data; for example, financial
statements and product pricing information. When you are required to enter data into a
spreadsheet for your organisation, you must first identify what kind of data it is and what
would be a suitable way to enter it. For example, a report containing mainly text would be
correctly entered using a word processing application, but data that has a lot of numbers
probably needs to be entered into a spreadsheet. Once you have entered data, you will need
to format it to suit your organisation’s style and presentation requirements. A spreadsheet is
easier to read when it has been formatted.

In this topic you will learn how to:
1A Adjust workspace, furniture and equipment to suit user requirements
1B Minimise wastage

1C Identify and clarify spreadsheet task requirements

Unit release 1 (Aspire Version 1.1)
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1 Adjust workspace, furniture and

equipment to suit user requirements

Workplace safety is everyone’s responsibility. Employers and employees must make an active
contribution to ensuring their workplace is safe. Hazards need to be identified and risks
assessed to reduce injury in the workplace. If you are working at a computer for an extended
period each day, your workstation must be comfortable and designed for you to carry out
your tasks efficiently. You will need to organise your work so that you are not doing a
repetitive task for a long time. You should also take time to stand up and stretch.

Another consideration in the workplace is to use resource conservation techniques to
prevent wastage. Most organisations require staff to follow resource-saving procedures
such as turning off lights in unused rooms and
recycling paper. You need to be aware of any
conservation efforts made by your organisation.

Workplace safety legislative
requirements

All work health and safety (WHS) legislation
requires employers to provide a safe workplace
and adequate training and supervision,

while controlling workplace hazards and risks. You must work in line with legislative
requirements, regulations, Australian and industry standards, and the relevant codes of
practice.

WHS legislation describes the legal requirements for ensuring workplaces are safe and
healthy, such as:

« managing risks to health and safety

« promoting and maintaining the health, safety and welfare of people at work

« protecting people at work from injury and illness, including psychological injury
« protecting the health and safety of the public in workplaces

« consulting workers and encouraging participation in maintaining WHS

o providing rehabilitation and maximum recovery for injured workers.

WHS policy

All workplaces in Australia are required to have a WHS policy that describes the
organisation’s responsibility for the health and safety of its employees. The policy should
include the organisation’s goals and objectives regarding WHS and a general set of
guidelines related to health and safety in the workplace.

The WHS policy will help you fulfil your duty of care as a worker for the organisation.

WHS procedures

WHS procedures are instructions developed to ensure all employees work safely and
effectively. In the context of working in an office and using a computer workstation, the
following information should be contained in an organisation’s WHS procedures.

Unit release 1 (Aspire Version 1.1)
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Information contained in WHS procedures includes:

» workstation ergonomics

« standard safety precautions and housekeeping

« safe handling of hazardous substances (e.g. cleaning products)

o emergency and fire drills

o hazard identification and risk control

o manual handling

« emergency contact numbers, including local doctors and hospitals
o location of first-aid equipment and first-aid officers.

WHS regulations

The WHS legislation of each state or territory is supported by regulations and codes of
practice. The WHS regulations support the legislation by outlining specific workplace health
and safety requirements that must be addressed.

The Model WHS regulations, which provide a framework that most states and territories
have adopted, have specific requirements for hazardous manual tasks that must be
addressed. These requirements are summarised below.

Manage risk

A person conducting a business or undertaking must manage risks to health and
safety relating to a musculoskeletal disorder associated with a hazardous manual
task, in accordance with guidelines for managing risks to health and safety.

Control measures N\

In determining the control measures to implement, the person conducting the
business or undertaking must have regard to all relevant matters that may
contribute to a musculoskeletal disorder, including:

e postures, movements, forces and vibration relating to the hazardous manual
task

¢ the duration and frequency of the hazardous manual task

¢ workplace environmental conditions that may affect the hazardous manual
task or the worker performing it

¢ the design of the work area
* the layout of the workplace
* the systems of work used

¢ the nature, size, weight or number of persons, animals or things involved in
carrying out the hazardous manual task.

\_ /

Code of practice: hazardous manual tasks

The WHS regulations determine that it is a legal requirement for the person conducting a
business or undertaking (PCBU) and workers to address hazardous manual tasks in the
workplace. A PCBU has a broad definition that includes both employers and supervisors.

Unit release 1 (Aspire Version 1.1)
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The code of practice for hazardous manual tasks was developed to provide guidance
on how to manage risks associated with those manual tasks with the potential to cause
musculoskeletal disorders (MSDs).

A PCBU must consult with workers, so far as it is reasonably practical, to develop their own
set of procedures to manage the risk of MSDs.

The hazardous manual tasks code of practice helps PCBUs and workers to:

o identify hazardous manual tasks

o assess the risks

o control the risks

« review the control measures.

Musculoskeletal disorders

MSDs come about in two main ways:

o Gradual wear and tear to joints, ligaments, muscles and inter-vertebral discs through
repeated or continuous use of the same body parts, including static body positions

« Sudden damage caused by strenuous activity or unexpected movements, such as when
loads being handled move or change position suddenly

The repetitive movements and sustained body position associated with entering data into a
computer is regarded as a hazardous manual task and puts the operator at risk of developing
an MSD.

MSDs may include conditions such as:

o sprains and strains of muscles, ligaments and tendons

o back injuries, including damage to the muscles, tendons, ligaments, spinal discs, nerves,
joints and bones

« joint and bone injuries or degeneration, including injuries to the shoulder, elbow, wrist,
hip, knee, ankle, hands and feet

« nerve injuries or compression (e.g. carpal tunnel syndrome)
« muscular and vascular disorders as a result of hand-arm vibration
o soft tissue hernias

o chronic pain.

Standard precautions

Your workplace may need you to use standard precautions,
particularly work practices related to the prevention of
repetitive strain injuries (RSIs). These include ergonomic
practices, workstation design, enforced breaks and exercise
routines.

Workers in an office environment follow standard precautions
when using a computer workstation. However, research on
sitting has demonstrated that other precautions also need to
be considered, such as the use of standing workstations, to
ensure that injuries are prevented. It is important that you
carefully follow any standard precautions that are prescribed
for your workplace.

Unit release 1 (Aspire Version 1.1)
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Equipment and systems safety checks

An important part of your daily work routine is to check the various systems and equipment
you will use during the day to make sure they are in correct working order. Your workplace
policies and procedures should include the steps to follow. You may need to perform this
procedure at the start of your working day or at specified intervals during the day.

Workstation safety procedure/checklist:

« Seat is positioned in front of your computer and you can reach your keyboard
comfortably.

« Computer monitor is positioned out of direct sunlight and at the correct height.

o Environment is dust-free as dust can affect the monitor or central processing unit of a
computer.

o Cables are secured so no-one trips over them.

« Blinds and window coverings are used to reduce glare and heat at your workstation.

o Temperatures don’t exceed 26 °C and humidity is between 40 and 60 per cent.

Use ergonomic practices in the workplace

The aim of ergonomics is to reduce the risk of accidents, injury and ill health by applying
safe work practices. Ergonomics is about creating comfortable working conditions by
adapting workstations, tools and equipment to an individual worker’s needs. It also
improves performance and productivity in the workplace. Ergonomics covers all aspects
of working, from physical stresses such as sitting at a workstation all day to environmental
factors such as noise, air-conditioning and lighting.

Set up your workstation

A workstation includes a computer, screen, keyboard, mouse, desk and chair. How your
workstation is designed can affect your health and wellbeing. Several physical problems can
result from poor workstation design; for example, lower back strain may result from sitting
in a chair that does not support your back. Below are some guidelines for setting up your
workstation to be ergonomically efficient.

Chair \

Adjust your chair height so that your feet are flat on the floor, your thighs are
horizontal and your lower legs are vertical to the floor.

Adjust the backrest by raising it to the maximum height and then lower it until
it fits the curve of your lower back. If this is not comfortable, lower it another
couple of centimetres. Continue this until a comfortable position is found. The
backrest should support your lower back.

The backrest may also be adjusted backwards and forwards. When seated in
your usual working position, move the backrest until it exerts a gentle pressure
on your lower back. Make sure there is at least two centimetres of space
between the front of the seat and the back of your knees. Armrests should be
positioned so that they do not interfere with carrying out your tasks.

Unit release 1 (Aspire Version 1.1)
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Desk \

When you sit at your desk, the surface should be just below your elbow height.

If your desk is not height-adjustable, try to raise your chair so you are sitting at
the correct height, and use a footrest to make up the difference. If your desk

is too low, you may be able to extend the legs. You should have plenty of leg
space underneath your desk. Don’t clutter the space with bags and bins, as your
legs may become cramped and your posture twisted. Position any equipment

or materials you use so that you can reach them easily without twisting. For
example, stationery items you frequently use should go in the top desk drawer,
and your keyboard and screen should sit directly in front of you to avoid having
to angle or twist your body.

/

Keyboard N\

The angle of your keyboard can be adjusted to suit your comfort level by moving
the supports underneath it. Place the keyboard as close as possible to the
front of your desk. Don’t place documents between yourself and the keyboard,
as stretching will eventually cause muscle strain in your arms, shoulders and
neck. While typing it is best not to rest your wrists, as they should not be bent
up, down, or to the side. The knuckle, wrist and top of the forearm should form
a straight line. Wrist supports or rests give you a place to rest your hands only
when pausing from typing, not while you are typing. Do not pound the keys; use
a light touch. Leave enough room on your desk to put the keyboard out of the
way when you are not using it.

/

Mouse \

Place the mouse and mouse mat directly beside your keyboard on the side you
prefer. If you use the mouse frequently, you could try to alternate sides. You

will be surprised at how easy this becomes with practice. Your wrist should be
straight, and the desk should support the weight of your wrist, not your arm. Try
to keep your wrist flat and rest your fingers on the mouse between clicks. Hold
the mouse lightly. Don’t hold onto the mouse when you are not using it.

/

Screen \

Once you have adjusted your chair and desk, you can position your screen.
Adjust it so that the top of the screen is level with or slightly lower than your
eyes. If you can’t adjust the screen to the correct height, place the screen on a
platform.

The screen should be at least 50 centimetres or an arm’s length away from your
seated position to minimise radiation exposure; however, you should always
adjust the position of the screen to suit you. It is best to position the screen so
that you can clearly read the text without leaning forward, twisting your neck, or
looking too far upwards. Also take surrounding factors into consideration, such
as reflection, glare and shadow, when positioning your screen.

/

6
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Workstation features

The features of an ergonomic workstation are highlighted in the diagram below. Some
features of the workstation may vary depending on the type of computer work being
performed. Graphic work may require the use of a pen tool, and multiple monitors are
commonly used for a variety of digital work.

Top of screen The screen angle should be adjustable between 85 and 125
degrees to the horizontal.

Centre of screen Minimise screen reflection and glare by using an anti-glare filter.

Bottom of screen Place a document holder beneath or beside the screen at the
same viewing distance as the screen.

Top line of sight The viewing distance should be between 400 mm and 700 mm.

Bottom line of sight A relaxed viewing angle is approximately 35 degrees.

Head Keep your head erect.

Shoulder Have your upper arms hanging freely.

Elbow Have your forearms approximately horizontal.

Above knee Ensure there is clearance between the lower edge of the desk and
your legs.

Below knee Ensure there is clearance between the front edge of the seat and

the lower leg.

Footrest Use a footrest if needed.

Back of chair The back support should be adjusted to support the small of your
back.

Under chair Adjust the seat height to suit your furniture and equipment.

Chair legs Use a chair with a five castor base.

Unit release 1 (Aspire Version 1.1)
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Desktop layout
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Items on your desk, including equipment and resources, should be arranged within
easy reach.

Your desk area can be divided into three zones:

o the optimum reach zone - the area closest to you, where your hands operate most of
the time

o the maximum reach zone - further away, but still close enough to reach comfortably
« the outer reach zone — where you may have to bend forward or stand to reach items.

Make sure your desk is organised so that frequently used objects, such as your keyboard,
are close to you. Intermittently used objects, such as your phone, should be out of the way
but still within easy reach. Other resources used less frequently, such as in- and out-trays,
should be in the outer reach zone.

Adjust your equipment and posture

When your posture is poor, you may suffer from aches and pains. Spending a long time in
the same position can put stress on your body and this can be made worse if you are in an
uncomfortable or poorly supported position. These symptoms may start out very slight, but
if you continue to use poor posture they may get worse and become intolerable. They may
result in cumulative stress given the constant stress on your muscles, nerves or tendons.
When setting up your workstation, you need to make sure your posture will not cause you
pain or discomfort. The equipment you use needs to be adjusted to suit your body shape and
size, and the tasks you are doing.

You have already looked at adjusting your screen and chair. There are other office tools that
can help your posture. These include the following items.

Footrests Headsets

A footrest may be necessary if you can’t If you use a telephone for long periods of

place your feet comfortably on the floor. time, it is a good idea to use a headset. A

Footrests allow your feet to rest at the headset will keep your neck straight and

correct height and on a tilting angle, which your arms free. Headsets prevent you from

prevents strain on the lower back. bending your neck to support the telephone
handpiece.

Unit release 1 (Aspire Version 1.1)
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Document holders Angle boards

Document holders are designed to hold Angle boards allow the user to maintain
papers and reference material in a correct posture when reading, by reducing
convenient position for viewing. Place your the angle between the work surface and the
document holder in the correct position. vertical posture. Adjustable to a suitable

If it is below the screen or too far off to height and angle, these supports enable
the side, each time your eyes look from comfortable reading with the neck correctly
one source to the other, your pupils have positioned. Try to keep your neck as straight
to adjust. Doing this for long periods of as possible when you are reading.

time can cause headaches and eyestrain.
Place the document holder at a similar
level, angle and distance as the screen to
avoid having to shift eye focus.

Home office

Communication technology and organisational policies to maintain a sustainable work-life
balance are creating opportunities for more flexible working arrangements. This means that
more employees are working from home offices or in other remote office locations. Many
benefits can be derived from flexible working arrangement for employers and employees,
but there is still a responsibility for all parties to make sure that home and remote offices use
ergonomic practices and follow WHS requirements.

Hot desking

Hot desking is an office organisation system that is used in some workplaces where
workstations are not assigned to an individual worker. Workstations may be used by
multiple workers during different time periods or shifts.

The motivation behind hot desking is primarily the cost savings achieved by setting up
fewer workstations in workplaces where not all the workers are in the office at the same
time, or not in the office for long periods at a time.

Another common adaptation of hot desking is where work stations are assigned to
individual workers, but need to be readily available for other workers to access based on
daily work requirements, such as a group of people coming together to work on a specific
project.

WHS and workplace culture considerations with hot desking

e |Itis common for workers to want their own space. Consequently, they may
tend to choose one location and stick to it.

* |t can take extra time each day to set up a work station for ergonomic and
work efficiency.

* Personal hygiene needs to be maintained to prevent the spread of germs on
keyboards and desk surfaces.

* Workstations need to be tidied appropriately in readiness for the next user.
This can also involve some cleaning.

Unit release 1 (Aspire Version 1.1)
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Standing desks

Sitting at a desk for long periods of time has many
negative health impacts. It is claimed that the negative
effects of prolonged sitting cannot be counteracted by
regular exercise and that the only way to eliminate this
problem is to avoid sitting as much as possible.

These negative health impacts can be overcome through
the use of standing desks. Standing provides a greater
opportunity for your body to move and adjust and
involves more muscular activity than sitting.

Some of the health benefits from standing include:

« alleviating back pain and other repetitive stress
injuries by greater use of core back muscles to support
the upper body

« increasing focus, alertness and activity level by releasing restless energy

» reducing the risk of developing cardiovascular disease, diabetes and blood clots, which
can be caused by prolonged sitting.

Standing desk ergonomics

Using a standing desk for hours on end requires you to adapt. It is recommended that you
start using a standing desk gradually by alternating between sitting and standing. You may
experience sore feet, tired legs and fatigue at first. Wear comfortable shoes and use an anti-
fatigue floor mat.

An ergonomically designed standing work desk means you can maintain correct posture
while working.

Position arms at 90 degrees when typing/standing.
Place the computer screen at eye-level and tilting it slightly upwards.
Place the computer monitor at least an arm’s length away.

Avoid leaning over the desk; keep your body straight.

Monitor environmental factors

Environmental issues in the workplace include lighting, noise control and air quality. If
the environment of your workplace is not monitored and controlled, you may sufter from
headaches, fatigue, hearing loss or eyestrain.

10

Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting



Topic1
Select and prepare resources

Light

Good lighting is essential for a safe and hazard-free workplace. You need to see things
clearly to work effectively. Simply shifting the screen slightly, adjusting blinds, altering the
brightness settings on the screen and using desk lamps can avoid many light hazards. Try
to use natural sunlight if the office layout can accommodate this. If not, keep bulbs and
fixtures clean, focus light on your task and use fluorescent lights if possible.

Improper lighting can cause eyestrain and headaches.

Hazards associated with lighting include:
o glare - a computer screen positioned in front of a bright window can be difficult to see

o flickering lights — a fluorescent light may malfunction, causing annoyance, irritation
and nausea

« inadequate or dim light - reading in dim light causes eyestrain
o reflections — sunlight reflecting on a screen can make it difficult to read

o shadows - shadows shifting across your work area can cause you to sit with bad posture
in order to read your work.

Noise

Noise can include any annoying or disturbing sound. Excessive noise around heavy
machinery or equipment can cause permanent hearing loss. Noise is a problem if it disturbs
people, distracts them, interferes with communication, causes people stress or generally
interferes with their work.

Many offices are open-plan in design, often with employees seated close to each other and
divided by partitions at chest or head height. Think about noise levels when you set up your
workstation. It should be possible for people in open-plan offices to have some privacy when
they are on the telephone and carrying out their day-to-day activities.

Noise in the office can come from:

« machines (photocopiers, fax machines, printers)

o other equipment (telephones, paging systems, music)

o background noise (lifts, air-conditioning, traffic)

o people talking.

Noise management

Noise can also be a problem outside office environments, such
as on factory floors, at construction sites or near airports. You
may have to wear ear protection if you are required to work in
excessively noisy areas.

There are many ways that problem noise can be controlled
in the workplace. Noisy machines can be put in a separate
room or area. Sound-absorbent materials such as carpet and
partitions can be installed or arranged to deflect and absorb
noise. The volume level on your telephone’s speaker can be
adjusted.

Remember that noise is only a hazard when it is stopping you from working productively,
comfortably and safely. Many people prefer to work with low levels of noise rather than
complete silence.

Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

1



12

BSBITU202
Create and use spreadsheets

Air
Air-conditioned offices do not have fresh air from open windows. This can cause problems
for some people.

Office workers frequently complain of being too hot or too cold. If a person’s desk is near an
air-conditioning outlet, the area around their desk can be much colder than elsewhere in
the office. They can also suffer from dry and itchy eyes. Report such hazards to the relevant
person. This situation can usually be corrected by adjusting air-conditioning flow.

Organise your work

Having a well-planned workstation and comfortable surroundings is pointless if you don’t
organise your work in a way that prevents discomfort or pain. Make sure you plan your
daily tasks so that you aren’t doing repetitive work for long periods of time. Make sure you
take rest breaks and exercise regularly.

Positive work organisation includes:

» amixture of repetitive and other activities
o rest periods

« exercise breaks.

Vary your activities

Your work role may involve several different tasks. Some tasks may be repetitive, such as
typing up reports or entering data. If you are able to vary the tasks you carry out each

day, this will help prevent repetitive actions that cause stress to your body. For example,

if you have to enter a lot of data, break up the repetitive nature of the task by discussing a
project with a fellow worker, collecting some research from the internet or doing another
constructive workplace task you are responsible for. Workflow should be designed to reduce
the repetitive tasks given to particular people.

Take rest periods

All employers need to provide rest periods for employees. Rest periods include tea breaks
and lunch breaks. During the working day everyone needs to sit down, breathe easily, relax
and take time to think about something other than work.

Have exercise breaks

When working with a computer, you should have short breaks at regular intervals to combat
stress and prevent pain and discomfort. As discussed previously, using computers for too
long without breaks has been associated with back and neck pain, headaches, migraines and
eyestrain.

Try the following exercises several times a day, and encourage others
around you to try them. Make sure you are relaxed and stretch gently,
without overstretching. Stop if you feel any pain or discomfort, and
remember to exercise both sides of your body. Most importantly, breathe
deeply and evenly throughout the stretch.

v1323
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Neck

Turn your head gently to look over your right shoulder. Hold for
10 seconds. Now roll your head forward to look over your left
shoulder and hold for 10 seconds. Repeat several times.

Shoulders

Sitting with a straight back and neck, roll your shoulders forward,
then back. Repeat several times.

Wrists, hands and arms

&

Interlacing fingers, turn palms upwards. Now lift arms over your
head and stretch, leaning gently to the left and then to the right.
Repeat movement several times.

Upper and lower back

In a standing position place hands in the small of the back.
Gently arch back and hold for 10 seconds. Repeat when needed.

Shoulders and arms

&

NGV N\

Stretch your arms above your head, cradle your elbow with your
hand and gently pull your elbow behind your head. Repeat on the
other side, holding the stretch for 10 seconds.

\_

Eyes

Every 20 minutes, look away from the screen. Focus on a distant
object (more than three metres away).

Work without stress

Here are some tips for working without stress.

Tips to help minimise stress

e Adjust your chair and desk to suit your body.

* Position your screen to suit your posture.

¢ Adjust other equipment for safe and comfortable use.

¢ Reduce excess noise.

* Ensure you have adequate light.

* Arrange your desktop so you can access things easily.

* Take regular breaks from your work.

¢ Frequently rest your eyes.

¢ Do stretching exercises.

e Vary your tasks.
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© Aspire Training & Consulting

13



BSBITU202
Create and use spreadsheets

Practice task 1

Here is a checklist to follow when setting up your workstation. Go through the points that are relevant
to you and make any necessary adjustments to your work or study space. You may need another
person to help you and check your posture. If you are not able to tick some of the checkpoints,
change your study space or discuss making alterations to your workstation with your manager.

Chair

Is the seat height-adjustable?

Is it high enough to allow you to sit comfortably over the keyboard?

Is it stable?

Does it swivel?

Is the height of the backrest adjustable and does it tilt backwards and forwards?
If it has arms, can you still get close enough to the desk and swivel the chair?
Are your feet flat on the floor, or are you using a footrest?

Ny [y Ny S I [y

Are you sitting up straight with the backrest firm against your back?

Desk

a Isitlarge enough to allow the screen and keyboard to be correctly positioned?
a Isitlow enough to allow you to keep your forearms horizontal or sloping downwards?
a Isit high enough to allow your thighs to fit underneath it?

Keyboard

a Can it be tilted to allow you to adjust it?
Q Are the symbols on the keys clear and easy to see?
Q Is there sufficient space in front of it to allow you to correctly position your arms?

Screen

a Does the screen have easily adjustable brightness and contrast controls?
a Is the image on the screen stable and flicker-free?

Q Are there adjustment mechanisms to allow the screen to be tilted, swivelled or raised to avoid
glare and reflections and help you keep a natural and relaxed posture?

Q Are you sitting far away enough from it for comfort?

continued ...

14

Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting



Topic1
Select and prepare resources

... continued

1. Describe the possible consequences for an organisation in which employees do not consider
their physical health.

2. What should a WHS policy include?

3. What should WHS procedures include?

4. Why should you vary the tasks you carry out each day?
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Minimise wastage

Conserving resources at work benefits not only the organisation by reducing costs, but also
the planet by reducing greenhouse gases and the amount of waste sent to landfill. Most

organisations have policies and procedures for conserving
resources. You can find out what these are by reading your
workplace manual or asking your manager or colleagues.

Ways to conserve resources at work include:

Minimise paper wastage

minimising paper wastage

reducing energy use.

Wasting paper costs organisations and the planet a great deal.
Consequently, many organisations have developed policies for paper usage. These include:

using both sides of the paper when photocopying

recycling non-confidential waste paper in recycling bins

storing email messages in an electronic folder instead of printing

reducing the volume of printing where possible

reusing paper by using blank sides for rough drafts and reusing folders and files
using recycled paper or paper from plantation timber for printed documents
using a recycling service to collect waste paper.

Example: office paper

Using the following statistics, consider how many trees are used for office paper.

How many trees are used to produce paper?

* One ton of uncoated virgin (non-recycled) printing and office paper uses 24 trees.

¢ One ton of 100 per cent virgin (non-recycled) newsprint uses 12 trees.

¢ One ream (500 sheets) of paper uses six per cent of a tree.

* One tree makes 16.67 reams of copy paper, or 8,335 sheets.

¢ One carton (10 reams) of 100 per cent virgin copier paper uses 60 per cent of a tree.

* One ton of coated, non-recycled higher-end magazine paper (used for high quality
photographic magazines) uses more than 15 trees.

* One ton of coated, non-recycled lower-end magazine paper (used for news magazines and
most catalogues) uses nearly eight trees.

The statistics in this example are based on US short tons (2,000 pounds), not metric tonnes.

Source: www.conservatree.com

16
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Minimise energy use
Wasting energy also costs organisations and the planet a great deal. Many organisations
have developed policies and procedures to save energy. These include:

« providing training programs on smart energy practices so that employees can practise
energy efficiency

 turning off equipment when not in use
« using power-save functions for equipment
« refilling toner and ink cartridges from printers.

Resource conservation

Here are some tips for practising conservation.

Resource conservation tips

* Use the power-save function on printers when they are not in use.
* Print and copy on both sides of the page, where possible.

* Use recycled paper (paper used on one side) in the photocopier and
printer for rough drafts.

* Use recycled paper for telephone messages.
* Place a recycling bin near the photocopier.

Practice task 2

1. List three policies developed to minimise paper wastage at your organisation, or one you are
familiar with.

2. List three policies or procedures developed to minimise energy use at your organisation, or one
you are familiar with.
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1 C Identify and clarify spreadsheet

task requirements

Organisations use spreadsheets to store and perform
calculations on numerical data. For example, sales
figures and payroll information are usually stored on
spreadsheets. Once the data has been entered,
calculations can be performed on the numbers to
produce a required result, such as total monthly
takings or a calculation on interest payments.

Many organisations have specific requirements

in relation to how data is stored and the way it is
displayed and presented. You must be aware of
these requirements so your spreadsheet meets your
organisation’s standards. These requirements may
be in relation to how the data is entered, stored,
presented, output or produced.

Requirements for the task may also be specified by your supervisor or the person requesting
the information. It is important to follow instructions and clarify requirements. Part of
clarifying requirements is asking questions; it may also include checking information and
the presentation of past spreadsheets, as well as showing someone a draft of the spreadsheet
prior to completion. Organisational and task requirement instructions form another type of
check for when you complete the task.

Spreadsheet software

In accounting, a spreadsheet is a large sheet of paper that displays a company’s financial
position. It spreads or shows all financial information (such as costs, income and

taxes) on a single sheet of paper for a manager to look at when making a decision. An
electronic spreadsheet organises information into columns and rows. The data can then
be manipulated by a formula to provide a total (sum). The spreadsheet can present the
information in a format to help a decision-maker see the financial ‘big picture’ of an
organisation.

All organisations need to manage and store numerical data and a spreadsheet is the
most appropriate tool for doing this. The most commonly used spreadsheet software is
Microsoft Excel.

Before you begin

Before you start entering data into a spreadsheet, you should be familiar with the screen
elements of a spreadsheet. Spreadsheets are made up of worksheets and workbooks. A
worksheet is divided into columns and rows and the intersection of a column and row is
called a cell. The current cell is shown by a highlighted rectangle that is called the ‘active
cell’. A workbook is a collection of worksheets.

The following example is Sheet 1 in Book 1. Al is the active cell.

18
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Worksheet
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If you look closely at this spreadsheet, you will notice there are a number of screen elements.
The following sections explain each of the screen elements.

Title bar

‘ BE S & s Eookl - breel

The title bar holds the name of the workbook. It has the standard minimise, restore and
close functions found in all Microsoft Office products.

Ribbon - tool buttons

In Microsoft Excel 2013, toolbars have changed significantly from earlier versions of the
program. The program now operates by using a number of tabs available from the ribbon.
These provide you with easy access to a wide variety of commonly used tools.

The ribbon has various tabs. You can easily switch between each tab to access tool buttons
that you might need to use.

FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ACROBAT

There are also other tools that are relevant to an action you are performing. For example,
when you choose to insert a chart, additional sets of tools appear under Design, Layout and
Format tabs.

Each tab has groups of tools available. For example, under the Home tab, the groups are
clipboard, font, alignment, number, styles, cells and editing.

Unit release 1 (Aspire Version 1.1)

© Aspire Training & Consulting 19



BSBITU202
Create and use spreadsheets

You will need to familiarise yourself with the various tools that are available in Excel 2013.
However, the most common tabs you will use are Home, Insert, Page Layout and View.

To learn about the various tool buttons, rest your mouse pointer on the button. A help
bubble that briefly describes the purpose of the tool button will appear.

Formula bar

Al Y| ¢ : Jfe v

A worksheet is made up of cells. The Formula Bar displays the current cell reference and is
used to view and edit a cell’s contents. When entering data in a cell, you will see cross and
tick buttons appear on the Formula Bar. These are the Cancel and Enter ticks.
Accept your entry by clicking on the tick (or simply press the Enter key on the keyboard), or
cancel it by clicking on the cross.

Active sheet

Sheetl | Sheetz & Sheet3 *

As per default workbook settings, each new workbook contains three blank worksheets.

It is possible to add or delete worksheets, and rename worksheets if you need to. An
example would be to have a workbook that contains yearly sales data where each worksheet
contains specific data (such as sales data for each quarter) and each worksheet is named
appropriately; for example, quarter 1, quarter 2, quarter 3, quarter 4. It is possible to view,
and work with, data contained in each worksheet by simply clicking on the sheet name.

You can rename a worksheet by right clicking on the existing name (for example, Sheet1)
and selecting Rename. Type in the new name and press Enter.

Enter data into a worksheet

Numbers and text can be typed into a cell. Text entries are called ‘labels’ and numeric
entries are called ‘values’. To enter data into a cell, you must first select it to make it active.

Enter data

The following steps show how to enter data to create a spreadsheet:
o Open Excel.
o Click inside C2 and enter Current Clothing Label.

o Enter Month, Income, Expenses, Profit and Clear Profit in the fourth row. Look at the
following example to help you.

« Enter January in A5 and select the cell. Use Fill to add the months in column A. The
Fill handle is a small black square at the bottom right of the cell .

Position your cursor over the Fill handle until a cross appears. While pressing the left
mouse button, drag the Fill handle down through the required cells until you reach
December, then release the button. Excel will automatically fill in the months for you.

« Enter values under Income and Expenses. You will be using the values you enter in
calculations later, so try to be accurate.

« Save your worksheet in a suitable location on your hard drive and name it ‘Current
Clothing’.

20
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Alter data

Once you have entered data, you may have to

Current clothing label

Income
5000
43543
3454
4500

Expenses

1222
500
324
400
300

3454

4322
543

2342
343

2234

alter it to correct errors or update it for changing

organisational requirements. You can alter the
information in a cell by selecting the cell and directly
entering the new information, or by using the

Formula Bar:
Click in the E4 cell Clear Profit. This cell is now

current.

This cell’s content will be displayed on the

Formula Bar.

Click on the Formula Bar to select it, or press the
F2 key on the keyboard. Change the word ‘Clear’

to ‘End’.

Press Enter or click the Enter tick

the change.

Clear profit

on the Formula Bar to confirm

Select one of the numbers you have entered in the Income column. Press the Delete key
to delete the information. Retype a new number.

Save your changes and close your worksheet.

Select cells

Once you have entered data into a worksheet, you will need to select data in order to format
it or perform calculations. You may need to select some or all of the data on a worksheet.

When data is selected, it is highlighted on the screen. The following information describes a
number of techniques for selecting cells.
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Select a group of cells by dragging the mouse

Click on the first cell in the range that you want to select. Hold down the
left mouse button and drag over the required cells. Alternatively, click on
a cell to select that single cell.

Select a row

Click on the row number button; for example | 4 ‘ .

Select a column

Click on the column letter button; for example A

Select the entire worksheet

Click on the button to the left of column A, or on the keyboard
press Ctrl and A.

Select multiple ranges

Select cells using any of the above methods and then hold down the Ctrl
key before selecting the second range of cells.

Storage, output and presentation

Once you have entered data into your worksheet, you

need to know what the required output is, how it should

be presented and where it should be stored. For example,
your manager may need you to enter monthly sales figures,
for which a total calculation must be made. In this case
you need to add a column with a label of “Total’. You may
need to format your spreadsheet to match organisational
requirements; for example, you may need to use a certain
font type and size for labels, and precise information in the
header and footer.

Where you store your spreadsheet depends on who needs
the information. When you create a spreadsheet, you need to save it immediately. You can
save it to your personal hard drive or to a shared drive on your organisation’s server. A
server is a computer that delivers information to other computers linked by a network. Ask
your manager where you should save your spreadsheet to ensure that you are adhering to
company protocols.

22
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Practice task 3

1. Describe the main purpose of a spreadsheet.

2. Describe the following components of a spreadsheet:
e Workbook

e Worksheet
e Cell

3. How do you make a worksheet current?

4. What function key will access the Formula Bar?

5. Describe how you can use the Formula Bar to alter data in a cell.
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Summary

1. Ergonomics is about creating comfortable working conditions. Setting up a workstation
to suit your physical requirements prevents undue stress and strain.

2. Environmental factors in the workplace, such as lighting, noise and air quality, affect the
health of employees.

3. Plan daily tasks and rest periods to prevent repetitive work being done for long periods
of time.

4. Performing exercises during the working day can prevent pain and discomfort.

5. Conserving resources at work benefits the organisation by reducing costs, and benefits
the planet by reducing greenhouse gases and the size of landfills.

6. Spreadsheets are made up of worksheets and workbooks. A worksheet is divided into
columns and rows, and the intersection of a column and row is called a cell.

7. You can change the appearance of your spreadsheet to suit your organisation’s style and
presentation requirements.

24
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Learning checkpoint 1

Select and prepare resources

This learning checkpoint allows you to review your skills and knowledge in selecting and
preparing resources.

Part A

1. List some reasons that a person may suffer physical discomfort when spending a lot of
time at a workstation.

2. For each reason you have listed, describe a solution that could relieve the physical
discomfort.
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3. Describe four types of office equipment you could use to help your posture in the
workplace. Explain the benefits of each piece of equipment.

Part B

Think about this statement: The environmental factors of a building can contribute to the
productivity of an organisation.

Write half a page describing how noise, light and air quality could affect productivity

at work.

Unit release 1 (Aspire Version 1.1)
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Part C

Using the table below, list as many conservation techniques as you can think of in relation to
two ways of conserving resources in an office environment: minimising paper wastage and
minimising energy use.

PartD

Read the case study, then complete the tasks that follow.

Angelina works as an administration officer. Her main tasks are reception duties, word
processing, handling the mail and filing. Most days Angelina’s manager gives her urgent work in
the afternoon that needs to be completed that day. Her time lines are always very tight and she
often finds that she has to work during her lunch hour and for an extra half-hour in the evening.
She is always exhausted and is becoming stressed.

To make matters worse, Angelina finds that work is often just dropped on her desk, which
makes her desk disorganised and difficult to use. She can’t alter her chair and there is glare
coming from her monitor. She often leaves work with a headache and a backache.
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1. List all the unsafe work practices Angelina is experiencing.

2. For each of the unsafe practices you have listed, describe a solution.
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3. On half an A4 page, describe why work organisation and ergonomics lead to better
employee health.

Part E

Which of the following data types would suit being entered and stored in a spreadsheet?
o Budget information

o Payroll data

o Areport about WHS

o Taxation information

o Superannuation contributions

o Aletter to a client

o Sales targets

o Bank reconciliation information
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Part F

Create the following spreadsheet, which provides a summary of sales results for sales

consultants at Henry Lewis Consulting & Co.

A B

3

5]

3 |

4 |

5 Month Hannah
6 |January 12334
7 |February 34543
8 March 3457
9 April 34534
10 |May 2367
11 June 88989
12 July 433
13 August 5678
14 September 7678
15 October 4564
16 November 7676
17 December 8909

1. Use Fill to create the list of months.

2. Alter the December figures as follows:

3. Save the document and name it ‘Henry Lewis - sales results’.

Hannah - 5909
Joe — 2343
Fredrick - 1231
Simon - 2324
Carolyn - 4358
Nim - 13210

C D E
Henry Lewis Consulting & Co
Sales results
Sales Consultant
Fredrick Simon
12324 5334 45434
23466 5456 12334
345 3432 23464
7767 2323 23662
34555 65655 25656
23424 66434 76743
23477 2454 13123
23244 2342 45536
23411 11230 32111
667 12311 634
2234 12345 23412
23435 12331 23234

Carolyn

2421
1243
3434
23534
45634
2342
53435
23423
23442
23665
6574
4357

Nim

1232
1245
4365
2341
5456
7675
4563
3245
2342
23231
12353
23210
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Producing a spreadsheet means creating it and having it ready for your colleagues or
supervisor to read. When producing spreadsheets, you need to check the data you
have entered for errors and make sure the content and format suit your organisation’s
requirements. For example, you may need to proofread the data manually or use the
spellchecker installed in the software you use.

If you have been asked to produce a spreadsheet, be aware of when the spreadsheet is
needed, so you can have it completed on time.

If you experience difficulties when producing a spreadsheet, you need to know where to go
for help; for example, you could use a paper-based manual or go online. You should know
which websites have up-to-date information about the software you are using.

In this topic you will learn how to:

2A  Enter, check and amend data while maintaining consistency of design and layout

2B Use software functions to format spreadsheets

2C Use and test formulas to confirm output meets task requirements

2D Overcome problems with spreadsheet design and production
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2 Enter, check and amend data while

maintaining consistency of design and layout

Data entered into Microsoft Excel worksheets consists y E T Yeary
) 1.000.000 525y o0 Yeors
of text, numbers or dates/times. Examples of text o 70000 16,200 009
entries include names, addresses and product 56%% ’,‘?;,‘35 Mosw  moow e
information. Examples of numbers include \ 0 w
quantities, customer numbgrs, pr.icing and sales :,‘_ooo e L ~>
figures. Examples of dates/times include dates of sale, s 3 e Expaae
dates of entry and monthly date ranges. When data is 000 T cosy o‘,}’:{
entered, Excel treats the data differently depending sater s
ey s . g
on whether it is text, numbers or dates/times. z%ﬁs 5 %00
Data must be entered, checked and adjusted as 455%‘&% ’ ong)
per organisational and/or task requirements. For it g;o - ,5% A
example, your organisation may prefer that dates & a2
. ¥ x)o )50 7
be formatted as follows: 27 Aug 16. So if a date ~n00 ~
was formatted as 27/08/2016, it would need to be
amended.
Data entry

To enter data into Excel, the cell in the worksheet must be activated. Entering data into a
blank cell only requires you to select the cell, type the data and press Enter on the keyboard.
The data will now be contained in the cell.

The automatic default for data entry in Excel is that each time you press Enter on the
keyboard, the activated cell will move down through the worksheet.

To adjust the way this works (for example, to make the next selected cell the one to the
right), select the File tab and click Options. Select Advanced and alter the Editing options
as follows:

Editing options

[V After pressing Enter, move selection

Direction: IRight - l

Edit data

To edit data (which means to change it), it is necessary to activate the cell contents. A
common processing problem occurs when people want to change the data; for example,
from Simon Jones to Simone Jones. Instead of editing the data only (that is, adding an ‘e’ to
Simon), people select the cell and retype all of the information.

The correct procedure is to activate the cell and adjust the entry as appropriate.
Any of the following actions will activate a cell:
o Double-click into the selected cell.

o Press F2 on the keyboard.
o Click into the formula bar of the selected cell and amend the entry.

32
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Text entry

Each cell in an Excel worksheet can contain approximately 32,000 characters. In most cases,
this is more than adequate for the data that each cell needs to contain.

When entering text, you will notice that after you have entered the data, it is automatically
aligned to the left of the cell. You will also notice that if there is no data in the adjacent cell,
the text will overflow across adjacent cells.

A B
Ingrid Heffernan

[

(VN] (%]

If, however, there is data in the adjacent cell, the text that is entered appears to truncate.

A B C
1 |Ingrid Hef Morris Green
=

<

Many people are confused by this and think that the data is lost. However, it is still
contained in the cell. If you select the cell again, you will notice that the formula bar (at the
top of the sheet) shows the full content of the cell.

To ensure the printed and on-screen versions of the document both show the full content
of the cell in the worksheet, you need to adjust the width of the cell and/or ‘wrap’ the text
within the cell parameters.

A B
1 |Ingrid Heffernan Morris Green
-

Number entry

When entering numbers, the automatic alignment will be to the
right of the cell. In most cases, if the number is longer than the cell,
the width of the cell will automatically adjust. The number of 1 123
characters for a value is limited to 15. -

Sometimes numbers do not appear as you expect, as in the
following example. This occurs when the number is too long
for the cell width.

Adjust the width of the cell to correct this problem.

A B
1 | 1.24E+12 Tom Evans

Date and time entry

Date and time entries also align to the right of the cell. When you enter

the data, date and time formatting is applied to the cell. In Microsoft 19-May-15
Excel 20%3, it tries to match the formatting with the way the information 2/07/2015
is typed in.
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Adjust cell width

The easiest way to adjust the width of a cell is to position = D
your cursor between the column headings at the top of the = ‘+‘
worksheet and drag the cursor right or left to where you want

the width of the cell to be.

Alternatively, you can AutoFit the cell width to the longest entry by double-clicking
between the column headings. The columns will automatically adjust.

To wrap text in a cell, select the cell(s) and use the Wrap Text tool = Wrap Text , which is
located on the Home tab.

Sort data alphabetically

Often, data needs to be sorted; for example, sorting customer

family names alphabetically, sorting in date order and sorting AY H
by customer reference number. Z

Sort & Find &
Filter » Select ~

2l SortAtoZ

To sort the data alphabetically, select the Sort & Filter tool from
the Home tab and then select Sort A to Z.

You do not need to select the data; just make sure the cursor

is located in the column you want to sort. Excel recognises £
adjoined columns and rows and sorts them appropriately. Excel

also recognises label headings and does not include these in the
sorting. 4

Sort Zto A
Custom Sort...
Filter

If, however, there are blank rows or columns, Excel will not

include these in the sorting. If you want blank rows and

columns to be included, you need to select the data to be sorted
first and then undertake the sorting.

Check data for accuracy

You must always check your spreadsheets for accuracy.
This may include double-checking with your supervisor to

make sure the data you have entered is correct. /

As well as checking the values that are entered, you must
make sure that any labels you have entered are spelt
correctly and that you have formatted all data to suit
organisational requirements.

Proofread Z
Proofreading is the process of carefully reviewing a J -

document for any mistakes. To proofread a spreadsheet, you need to check for errors in
values and labels.

To check values, you can compare the values you have entered with the values you were
given. Make sure that you have not made any errors when copying values and that you have
entered all the data in the correct places.

34

Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting



Topic 2
Create simple spreadsheets

ABC

To check errors in labels, you can use the Spelling function \/ » under the Review tab. This
will pick up words you have misspelt, but will not help you with product names or customer
names and addresses. The function will also not help where a word is spelt correctly but is
the wrong word; for example, ‘they’re’ instead of ‘their’.

Make sure you manually check your spelling and cross-check it with any documentation
you used to enter the data. For example, you may have been given a printout of all customer
names that were to be entered. Once you have entered the customer names, check them for
accuracy against the printout.

Validation rules

When creating a worksheet, you can add validation rules in cells to ensure that anyone else
who adds data has to make entries in the correct format.

For example, you may want only numbers or dates to be entered into certain cells. To do
this, you need to set validation rules in your worksheet.

Follow these steps to set validation rules.

1. Open an Excel worksheet. Look at the following sample and enter the same data into your
worksheet. This worksheet is to record product codes that have one letter and two digits.
The month columns record the units of products sold in that month. Save the worksheet as
‘Validation rules’.

A B C D E F
1
2 Product Codes
4 |Code January February March  April May
5
6
7
8
9
10
11
12
13
14
15

continued ...
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... continued

2. Select cells A5 to A12.

=/ et .
3. From the Data tab, select the Data Validation tool == Pata Validation . You will see the

following Data Validation dialog box. From this dialog box, you can set the criteria for what can be
entered into the cells you have selected.

4. Select ‘Text length’ from the Allow box. This option enables you to decide how many characters
or digits you will allow in a cell.

5. From the Data field select ‘between’ and in the Minimum and Maximum fields enter ‘3". This

means only three digits or characters are allowed in the selected cells. Click OK to save these
rules.

6. Now try to enter four digits into one of the worksheet cells. Excel should display the following
message:

This message tells you that your entry is invalid, but it does not tell you what you should enter.
You can change the error message to tell a user exactly what should be entered into a cell.

continued ...
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... continued

7. Select the Data Validation tool again. From the dialog box, select the tab Error Alert.
8. In the Error message, enter ‘You must enter one character and two digits’. Click OK.

You must enter one character
and two digits

9. Now try to enter four digits into one of the worksheet cells. Excel should display an error message
saying that you should enter one character and two digits.
If you set a validation rule, always create an error message that helps your colleagues enter the
correct data.

Unit release 1 (Aspire Version 1.1) 37
© Aspire Training & Consulting



BSBITU202
Create and use spreadsheets

Check calculations

When using formulas and functions, you need to
make sure that the result you get is the result you
want. If you are working under tight deadlines, it is
easy to make mistakes, such as subtracting one cell
from another instead of adding them.

Always test your formulas and functions before using
them in your spreadsheet. You can do this by using

a calculator to work out the result. When you have
designed a formula and used it in your spreadsheet,
you can check the result against the result your
calculator gave you.

You should also check the consistency of information
against the original data and check that the cell
references, mathematical operators (symbols) and functions used are correct.

Sometimes this is as simple as giving the information you have produced to a colleague or
supervisor to check in draft form, before you complete the final version.

Follow instructions about content and format

There are often guidelines or instructions for producing a spreadsheet when completing
tasks. These may relate to the content of the spreadsheet or its format and layout.

You may be asked to prepare a report about stock on hand and to arrange the data in
product code order, highlighting the quantity on hand and the quantity on order. You may
also be asked to check product codes with the product description.

These are specific instructions on how to produce the spreadsheet. If these instructions
are not followed, it may delay the final production of the spreadsheet. It may also affect the
effectiveness of the report and/or the accuracy of information.

If you are not sure, it is always important to clarify instructions and ask questions about
what else may be needed. If you have your own ideas on how the content or format of a
spreadsheet could be improved, speak to your supervisor.

Practice task 4

1. Practise entering this data into a blank spreadsheet.

Mary Buchanin 29 Green Rd, Altona 3018 9983 0194
Ginger Smith 988 City Rd, Melbourne 3000 9876 3939
Lionel Ha 1/23 Brown Rd, Laverton 3028 9762 8373
Ali Simoghin 21/1 Tree St, Williamstown 3016 9853 8391

AutoFit the column width to enable all the data to be viewed.

e Sort the data from A to Z based on name.
¢ Save the worksheet as ‘Customer contacts’.

continued ...
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... continued

2. Look at these examples of a worksheet and documentation used to enter data.

W 00 N O 0 & W N =

=
o

Customer accounts worksheet

5

D

1

Custoemr Accouints

Customers Balance 10% Interest New Balance

Smithe
Cartter
Andrew
Philips
Elliott
Frank
Luiee

$5,500.00
$4,000.00
$3,450.00
$300.00
$2,500.00
$500.00
$34.00

$550.00
$400.00
$345.00
$30.00
$250.00
$50.00
$3.40

Customer documentation

$6,050.00
$4,400.00
$3,795.00
$300.00
$2,750.00
$550.00
$37.40

Smith 55.00

Carter 4,000.00
Andrews 3,455.00
Phillips 3,000.00
Elliot 2,500.00
Franks 5,000.00
Luie 34.00

Cross-reference the worksheet with the customer documentation. Count how many errors there
are in the worksheet.

3. What should customer Smith’s new balance be?

4. Recreate the ‘Customer accounts’ worksheet with accurate information.

5. Select cells B5 to F15 from the ‘Validation rules’ worksheet from the previous example. This
covers all the values to be entered under the five months. Add a validation rule to these cells that
ensures only numbers can be entered into them. Write an error message to help colleagues if
they try to enter the wrong data. Test your validation rule to make sure it works.
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2 B Use software functions to format spreadsheets

When you have created a spreadsheet, you will find
that some adjustments are required before the
spreadsheet can display data to organisational
requirements.

For example, you may have to add columns and rows
to enter new data, or resize columns and rows to fit
data that has already been entered.

Adjust column width

There are two main ways to adjust the width of
columns in a spreadsheet. You can use Format

] Format ~ from the Cells tools on the Home tab to
adjust the width of columns.

Alternatively, you can adjust the width manually by dragging the column to the required
width, or Excel can automatically adjust the width for you.

Steps to manually adjust column width

* Open the ‘Current clothing’ worksheet.

* Move your cursor to the vertical line between the column headings. The
cursor should change into a two-headed arrow.

¢ Click and drag the two-headed arrow until the column is the required
width.

¢ Select another column that needs resizing.

* Move your cursor to the vertical line between the column headings until
the cursor changes into a two-headed arrow.

¢ Double-click on the vertical line. Excel will choose the best fit based on the
largest cell entry in the column.

¢ Save the worksheet.
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Adjust row height

You can use Format (=] Format* from the Cells tools on the Home tab to adjust the height
of rows.

You can also adjust the height of rows manually by following these steps:

Move the cursor to the horizontal line between the row numbers. The cursor should
change into a two-headed arrow.

Click and drag the two-headed arrow until the row is the required height.
Select another row that needs resizing.

Move your cursor to the vertical line between the row numbers until the cursor changes
into a two-headed arrow.

Double-click on the vertical line. Excel will choose the best fit based on the largest cell
entry in the row.

Save the changes.

The following steps show how to insert a new column.

1.
2.

Select Column E, called ‘End profit’.

Go to the Home tab and select the down arrow on Insert from the Cells tools. Select Insert Sheet
Columns. A new column will be inserted to the left of ‘End profit’.

Select cell E4, which will become the label of the new column.
In the formula bar, enter ‘Tax’. This column is to calculate the tax on monthly income.
It should look like the following example. Save the changes and close the worksheet.

A B C D E F
1
2 Current clothing label
4 |Month Income Expenses Profit Tax End profit
5 |January 5000 1222
6 |February 43543 500
7 |March 3454 324
g8 April 4500 400
9 May 4500 300
10 |June 55000 3454
11 July 43543 4322
12 |August 3454 543
13 September 3453 2342
14 |October 32552 343
15 November 39800 2234
16 |December 34000 100

o
To add a new row, from the Home tab, select the down arrow on Insert = Insert = from the Cells
tools. Select Insert Sheet Rows. A new row will be inserted above.

o,
D,

To delete a row or column, select the down arrow on Delete £ Delete - from the Cells tools. Select
the appropriate option (that is, column or row) to delete.
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Alignment within cells

As discussed previously, text and values align differently within cells by default: text aligns
to the left, numbers to the right.

To adjust the horizontal alignment of data within a cell, simply select the cell or cells

and choose the appropriate alignment tool from the Home tab. =- = == Horizontal
alignment options include left, centre and right.

The alignment of data within a cell can also be adjusted for the height of the cell. The default
is to align the text to the bottom of the cell. Data can be aligned to the top, centre or bottom
of a cell. Text can also be oriented to be on an angle.

To adjust the vertical alignment of data within a cell, simply select the cell or cells and
choose the appropriate alignment tool from the Home tab. = = _ -

Another common tool used to align cells is the Merge & Centre tool. This is commonly used to align
a heading across the width of data in the spreadsheet.

In the following example, the heading ‘Henry Lewis Consulting & Co’ and the heading ‘Sales results’
have been merged and centred across columns A to G (A:G).

A B C D E F G
1 Henry Lewis Consulting & Co
2 Sales results
4 Sales Consultant
S |Month Hannah Joe Fredrick Simon  Carolyn Nim
6 January 12334 12324 5334 45434 2421 1232
7 |February 34543 23466 5456 12334 1243 1245
& 'March 3457 345 3432 23464 3434 4365
9 |April 34534 7767 2323 23662 23534 2341
10 |May 2367 34555 65655 25656 45634 5456
11 June 88989 23424 66434 76743 2342 7675
12 July 433 23477 2454 13123 53435 4563
13 |August 5678 23244 2342 45536 23423 3245
14 September 7678 23411 11230 32111 23442 2342
15 |October 4564 667 12311 634 23665 23231
16 |INovember 7676 2234 12345 23412 6574 12353
17 'December 8909 23435 12331 23234 4357 23210

To perform this action, each row is dealt with separately:

1. First, the data from cells A1:G1 is selected and then the Merge & Centre tool
Merge & Center ~ on the Home tab is selected.

2. Next, the data from cells A2:G2 is selected and then the Merge & Centre tool is selected. This
provides the data with a centred heading.
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Example: alignment of a spreadsheet

The default alighment for printing a spreadsheet is that the data is aligned to the left and top of the
page in line with the margins. In many cases, especially in smaller reports, it is preferable to centre
the data on the page both vertically and horizontally.

To do this, first preview the spreadsheet to check what the information will look like before it is
printed out.

1. To preview, select Print from the File tab.
2. Select the Page Layout tab.
3. Select the Margins drop-down menu, then select Custom Margins.

4. Check the options to centre on the page - both horizontally and vertically. The display in the
dialog box shows how the changes will appear in the spreadsheet. Select OK. When printed, the
data will now be aligned vertically and horizontally on the page.
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Orientation of a spreadsheet

When printing a spreadsheet, the default setting is set to print in portrait orientation. In the
workplace, however, it is common for Excel reports to be printed in landscape orientation.
In most cases, this is because the reports contain more data that spreads across the page,
rather than down the page.

%‘W N
To alter the orientation of your report, from the Page Layout tab select ] ID “

Orientation and then select Landscape. Orientation Size |
- - A
If not all of your data appears on one page and some spills over to the

next, you can force the data to be scaled to the size that you prefer (that D Portrait
is, 80% of size or fit one-page wide by one-page tall). Scaling options
are available under Settings in Print. D ihace

Simple calculations in Excel

Excel is used to calculate a variety of data; for example, in financial reports, sales statistics
and stock levels. Routine or simple calculations are often performed to calculate data.

An Excel calculation always starts with an = sign and can include any of the following
mathematical operators:

o *(multiply)
o/ (divide)
e+ (add)

e — (subtract)
o % (per cent)
o A (exponential)

Mathematical rules

The mathematical rule of BODMAS is applied in Excel spreadsheets when performing
calculations. That is, Excel calculates information in brackets first, then orders, then division
and multiplication, then addition and subtraction.

Calculations can be performed either on values (for example, 1, 2, 3) or on the cell reference
(for example, A1l). When calculating data, it is always better to use the cell reference (for
example, A15), as opposed to the value (for example,
783). This ensures that the data entered is accurate,
as the information is taken directly from the cell
instead of you having to retype it.

It also assists by saving time - for instance, if the data
in the cell changes, the calculation will be updated
automatically as long as you used the cell reference.
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Formula efficiency

Formulas in Excel are only as efficient as the person
entering the data. If you make an error when typing
or entering the data or cell reference, the calculation
will be incorrect. If you choose the incorrect operator
(for example, *, +, /, -) for a calculation, the result will
also be incorrect.

Great care needs to be taken to ensure that the data
entered is accurate. You need to manually check the
values entered, as well as the cell references, and to
be familiar with the operators and functions that
you use.

The use of formulas and functions saves a lot of time
and makes the preparation of reports and statistical
data efficient.

As discussed earlier, it is always best practice to use cell references (for example, A1) where
possible in calculations. This ensures that the data is accurate and also saves time if the data
in the cell changes, as the calculation will be updated automatically.

In addition, it is a better habit to use your mouse to point and select the cell reference,
as opposed to typing it in, to ensure you have selected the correct information for the
calculation.

All calculations begin with the = symbol. If this is not present, Excel will not recognise the
entry as a calculation, but will assume that it is simply a text entry.

Format spreadsheets

You can change the appearance of your spreadsheets to suit your organisation’s style and
presentation requirements.

You can adjust the appearance of a cell’s content by altering how it is aligned, its font and
whether it has a border or pattern. If the cell has a numerical value, you can alter how this
value is displayed by converting it into currency, a percentage, a fraction or a scientific
number.

Find out the style and presentation requirements for spreadsheets in your organisation.
In the following exercises, you will be formatting a spreadsheet you have created.

Formatting your spreadsheet has a number of advantages:
« Creating an efficient layout to make the information clearer and easier to read
» Making data input easier

« Making your spreadsheet comply with organisational style and presentation
requirements
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Example: format labels

Earlier you learnt that text entered into a cell is called a label.
The following steps show how to format labels:
1. Open the ‘Current clothing” worksheet.
2. Select the cells that contain ‘Current clothing label’.
3. From the Home tab, select Font to access the Format Cells dialog box.
|Calibri u A ==E ¥ EwepTer General
B I U- . H-Ap- ===

& 3= B Merge & Center ~ $ ~ Y

Font 1] [: Alignment ] Nt
j} : ’ S v £ H* Font Settings (Ctrl+Shift+F) B
S g S AlS Al |1 ﬁ Customize your text to give it the —

B c D :__E"—"E- —'| exactlook youwant.

You can add a variety of styles and
colors to your text, as well as visual
effects such as strikethrough and
superscript.

4. The dialog box will display as follows:

El Adobe Caslon Pro
Adobe Caslon Pro Bold
Adobe Devanagari

continued ...
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... continued

5. Select Garamond, Bold Italic, 18. Click OK.

6. Select cells A4 to FA. This should cover all the headings of your columns.

7. Using the Font tools, change the font selections. Select Garamond, Bold, 14.

8. Select cells A5 to A16. This should cover all the month labels.

9. Using the Font tools, change the font selections. Select Garamond, Bold, 12. Click OK.

10. The worksheet should now look like the following example. Adjust the column widths to suit the

formatting.
Current clothing label
Month  Income Expenses Profit Tax End profit
Januvary 5000 1222
February 43543 500
March 3454 324
April 4500 400
May 4500 300
June 55000 3454
July 43543 4322
August 3454 543
September 3453 2342
October 32552 343
November 39800 2234
December 34000 100

Example: format values

Earlier you learnt that a number entered into a cell is called a value.

The following steps show how to format values:

1. Open the ‘Current clothing” worksheet.

2. Select cells B5 to F16. This will select all the cells where values have been inputted.
3. From the Home tab, select Number to access the Format Cells dialog box.

’General -| E=2) E} Iiﬁi"’lnser@: - >,
e - g7 Delete ~ N~
$-9% 2 %58 Conditional Formatas Cell =3 7 <
' " Formatting~ Table~ Styles~ Format~ & - ¢
Number e Styles Cells
Number Format

Don't see what you're looking for?

Check out the full set of number =
formatting options.

continued ...
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... continued

4. The dialog box will display as in the following;:

|E Adobe Arabic
Adobe Caslon Pro
{& Adobe Caslon Pro Bold

5. Under the Number tab, select Currency. Check the symbol and
adjust if required. Click OK. Your values should now be Currency 33
formatted as currency. If some of your values are not
displayed correctly, adjust the column width until they are $ >~ 05 9 ‘_38 .£8

clearly displayed.

Alternatively, you can use the Number Formatting tools to quickly Number [P
adjust the way values are displayed.

Example: add borders and shading

You can make data in your spreadsheet more noticeable by using borders and shading. A border
alters the appearance of the cell wall and shading alters the colour of the cell.

The following steps show how to add borders and shading.
1. Open the ‘Current clothing” worksheet.
2. Select cells A4 to F4. This should cover all the headings of your columns.

3. From the Home tab, select © in the Font section to access the Format Cells dialog box and then
select the Fill tab.

continued ...
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... continued

Automatic v

Select a pale colour and click OK.
View the colour on your spreadsheet; if you don't like it, change it now.
Select cells A5 to A16. This should cover all the month labels.

N o ok

From the Home tab, select = in the Font section to access the Format Cells dialog box and
select the Fill tab. Select the same pale colour you used for the column headings. Click OK.

8. Select cells Al to F19. From the Home tab, select = in the Font section to access the Format
Cells dialog box and select the Border tab. Look at the following example to help you:

9. Select a style of your choice, then Outline. Click OK.

10. To view your formatting, select the File tab (R then select Print.
11. To return to your spreadsheet, select the Home tab.
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Example: add a header and footer

You may need to adjust your spreadsheet by adding additional information in a header or footer. In
this exercise, you are going to add a header and footer to your spreadsheet.

The following steps show how to add a header and/or footer.

1. Open the ‘Current clothing’ worksheet. B
2. From the Insert tab, select the Header & Footer tool . 8'1';0':;

Now there should be a header section in your document for you to work in. There is also a new
group of tools available for your use under a tab called Design.

BEEE rove  mRT PAGELAYOUT  FORMULAS  DATA  REVEW  VIEW  ACKOBAT DESGN
o S B S e , _ .
I | l—l]. l ") "fL‘| @ (:lﬁ =y u'; ,,:_J ‘ o ‘.f t | Diffecent First Page o Scale with Document
Header Footer  Page Number Current Current  File  File  Sheet Picture Tomm Cuto Gote Diffesent D44 & Even Pages (¥ Align with Page Marging
. Number of Pages Date  Time  Path  Name Name Puture  Header Footer
Heades & Footer Header & Footer Brments Mavigation Qptna

You can type directly into the header section or you can use the new tools to insert useful
information such as a date or page number.

3. To insert a footer, select the Go to Footer tool and type directly into the footer section, or use the
Design tab tools.

4. Using these options, insert an appropriate header and footer into the spreadsheet.

5. Select Print from the File tab to preview the spreadsheet. If you are unhappy with its appearance,
make appropriate changes.

6. Save and close your worksheet.

Practice task 5

1. Remembering the order in which Excel performs functions, work out the following calculations.
a) =23+24*2

b) =20+40%5
) =100+2+30%4
d) =(15-5)*5

continued ...
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... continued

2. Create this spreadsheet, which provides a summary of sales results for sales consultants at
‘Henry Lewis Consulting & Co’. Then complete the tasks that follow.

» A B C D E F G
1 Henry Lewis Consulting & Co
2 | Sales results
3 {
4 | Sales Consultant
5 'Month Hannah Joe Fredrick Simon  Carolyn Nim
6 January 12334 12324 5334 45434 2421 1232
7 :February 34543 23466 5456 12334 1243 1245
8 March 3457 345 3432 23464 3434 4365
9 lApriI 34534 7767 2323 23662 23534 2341
10 'May 2367 34555 65655 25656 45634 5456
11 June 88989 23424 66434 76743 2342 7675
12 July 433 23477 2454 13123 53435 4563
13 |August 5678 23244 2342 45536 23423 3245
14 September 7678 23411 11230 32111 23442 2342
15 :October 4564 667 12311 634 23665 23231
16 .November 7676 2234 12345 23412 6574 12353
17 ;December 8909 23435 12331 23234 4357 23210

* Use Fill to create the list of months.
* Alter the December figures as follows:
- Hannah: 5909
- Joe: 2343
- Fredrick: 1231
- Simon: 2324
- Carolyn: 4358
- Nim: 13210
* Save the document and name it ‘Henry Lewis - sales results’.

* Practise using the alignment tools to adjust how the data sits within the cells - alter the width
and height of columns and rows to see how using the alignment tools alters the viewed data.

* Use the Merge & Centre tool to create headings for the spreadsheet.
¢ Centre the data on the page both horizontally and vertically.

* Print Preview the report.

* Change the orientation from portrait to landscape.

* Preview the report.

* Inanew column labelled ‘Summary monthly totals’, calculate the total sales figures for each
month. For example: =B6+C6+D6+E6+F6+G6. (Make sure you use the mouse to point and
select each cell reference.)

* Manually check the calculations using a calculator.
* Change the font type to Arial 14 point (pt).
* Bold the heading and the summary monthly totals.

continued ...
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... continued

Italicise the month and sales consultant labels.
Adjust the column width as needed.

Use the Number Formatting tools to make sure all commission and total figures are displayed
in currency ($) with two decimal places.

Adjust the column width as needed.
Place a dark border around the outside of the data.

Using the Fill tools, shade the list of names and associated data green and then shade the
summary total a different colour.

Shade the month names the same colour as the summary total. Shade the report heading a
different colour.

Preview your work. Save your changes.

Add a header with today’s date and time.
Add a footer that displays the page number.
Preview your work.

Save your changes and close.
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Use and test formulas to confirm

output meets task requirements

Formulas and functions in Excel are used to perform £.301 51654 52777 i
calculations. A formula is an equation that performs
calculations on data. It is used to calculate numerical 145 884.07
data. Formulas and functions can include cell
references and mathematical operations such as
addition and subtraction. For example, D5+E6 is a
formula.

813

9.515
901,757

A function is a calculation that uses a mathematical,
statistical or financial operator. Excel provides a
range of commonly used functions, such as SUM
and AVERAGE. For example, SUM(B5:B17) uses the
SUM function to add all the values in the selected
cell range.

963411

11,691

57497

Depending on your organisation’s requirements, you may have to use values in your
spreadsheets to generate new values, such as the GST of a product or service, or an
increase in product prices. Formulas and functions allow you to generate new values using
existing values.

Example: create a simple formula

The following shows how to create a formula to calculate values for the Profit column in the ‘Current
clothing” worksheet. When creating a formula in Excel, use the cell references of the cells you want
to use in your calculations. For example, =A3+B3 adds the values in the cells A3 and B3.

1. Open your ‘Current clothing’ worksheet.

2. Select D5, the first empty cell under ‘Profit’. Enter the formula =B5-C5. Use the following
example to help you:

A B c D | E F

1 5
Current clothing label |

4 Month  Income Expenses Profit Tax End profit.
5 |January | $5000.00]  $1,222.00|=55-C5 |
February $43,543.00 $500.00 .

7 |March $3,454.00 $324.00
g April $4,500.00 $400.00 ;

3. Press the Enter key to perform the calculation.

continued ...
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... continued

4. Once you have a calculation, you can use Fill to perform calculations in the remainder of the
column. Click and drag the D5 Fill handle down to D16. Your worksheet should now look like the
following example:

A B C D E F
1
2 Current clothing label
4 Month  Income Expenses Profit Tax End profit.
5 January $5,000.00 $1,222.00 $3,778.00
6 February $43,543.00 $500.00  $43,043.00
7 March $3,454.00 $324.00 $3,130.00
g |April $4,500.00 $400.00 $4,100.00
9 May $4,500.00 $300.00 $4,200.00
10 |June $55,000.00 $3,454.00  $51,546.00
11 July $43,543.00 $4,322.00  $29,221.00
12 |August $3,454.00 $543.00 $2,911.00
13 |September $3,453.00 $2,342.00 $1,111.00
14 |October $32,552.00 $343.00  $32,209.00
15 November $39,800.00 $2,234.00 $37,566.00
16 [ December $34,000.00 $100.00  $33,500.00

5. The values in the ‘Tax’ column need to be calculated as 10 per cent of the profit. In E5 enter the
formula =10%*D5 (this will give you 10 per cent of the value in D5). Look at the following example

to help you:
A B C D E F
1
2 Current clothing label
3 |
4 Month Income Expenses Profit Tax End profit
5 |January $5,000.00 $1,222.00l  $3,778.00=10%*D5 | i
6 February $43,543.00 $500.00  $43,043.00
7 'March $3,454.00 $324.00 $3,130.00
8 |April $4,500.00 $400.00 $4,100.00

6. Press the Enter key to perform the calculation. Fill the calculation down to December.

7. Select F5, the first empty cell under ‘End profit’. Enter the formula =D5-EB5. This calculation
subtracts ‘Tax’ from ‘Profit’, giving you the ‘End profit’ values. Use the following example to help

you:
A B C D E F
1
2 Current clothing label
4 Month  Income Expenses Profit Tax_End profit
5 |January $5,000.00 $1,222.00!  $3,778.00| $377.801=D5-E5 |
6 February $43,543.00 $500.00  $43,043.00  $4,304.30
7 March $3,454.00 $324.00  $3,130.00 $313.00
& April $4,500.00 $400.00  $4,100.00 $410.00

8. Press the Enter key to perform the calculation. Fill the calculation down to December.
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Simple functions

Functions can be used in Excel to perform a variety of mathematical, statistical and
financial calculations. As well as adding up values, functions can also determine values such
as the maximum, minimum or average from a range of cells.

Look at the following information about Excel functions.
=SUM(range)

This adds the values specified within the brackets.

=MAX(range)

This returns the highest value from the values specified within the
brackets.

=MIN(range)

This returns the lowest value from the values specified within the
brackets.

=AVERAGE(range)

This returns the average value calculated using the values specified
within the brackets.

=COUNT(range)

This counts the number of items in the range.

=NOW()

This inserts the current time and date.

=RAND()

This inserts a random number between O and 1.
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Example: use a simple function

The following steps show how to use a function to calculate totals in the ‘Current clothing’
worksheet. It shows how to use the SUM function to add the totals for each column of the worksheet
that has a numerical value.

1. Select cell A18 on your worksheet and enter ‘Totals’. f

2. Select cell B18. From the Formulas tab, select the Insert Function button e
You will see the following Insert Function dialog box. Highlight SUM and click OK.

Type a brief description of what you want to do and then 4
click Go
[ 3 Most Recently Used B

3. You will see the following SUM dialog box. As you have selected a cell at the end of a column full
of numerical values, the SUM function is going to add all of these values together. Number 1
shows the formula that the SUM function will use to make the calculation and the formula result
is displayed at the bottom of the dialog box. Click OK.

4. Cell B18 should now hold the calculation of all income values added together.

continued ...
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... continued
5. Select the cells C18, D18, E18 and F18 one at a time and use the SUM function to add the

values of their corresponding columns. Your worksheet should now look similar to the following
example:

Current clothing label

Month Income Expenses Profit Tax End profit
January 55,000.00 $1,222.00 $3,778.00 $377.80 $3,400.20
February $43,543.00 S$500.00 $43,043.00 $4,304.30 $38,738.70
March $3,454.00 $324.00 $3,130.00 $313.00 $2,817.00
April $4,500.00 $400.00  $4,100.00 $410.00 $3,600.00
May $4,500.00 $300.00  $4,200.00 $420.00 $3,780.00
June $55,000.00 $3,454.00 $51,546.00 55,154.60 $46,391.40
July $43,543.00 $4,322.00 $39,221.00 $3,922.10 $35,298.90
August $3,454.00 $543.00  $2,911.00 $291.10 $2,619.90
September $3,453.00 $2,342.00 $1,111.00 $111.10 $999.90
Ocrober $32,552.00 $343.00 $32,209.00 $3,220.90 $28,988.10
November $39,800.00 $2,234.00 $37,566.00 53,756.60 $33,809.40
December $34,000.00 $100.00 $33,900.00 $3,390.00 $30,510.00
Touals $272,799.00 $16,084.00 $256,715.00 $25,671.50 $231,043.50

AutoSum

The AutoSum icon = is under the Home tab in the Editing grouping. AutoSum enables
you to add values automatically using the SUM function. Simply select the range of values
that you want to calculate and click the AutoSum icon.

Use the Fill handle [:! to repeat the sequence of the function.

Relative and absolute cell references

The cells in an Excel spreadsheet are all relative to each other. This means that if you place a
value in one cell and then move it, the values will alter as the cell collects information from
other cells around it.

For example, the totals you calculated for each of your columns may need to be moved to
another part of the spreadsheet. However, if you move these totals to another location, their
values will alter as the cells are no longer reading information from the cells immediately
above them. This kind of reference is called a relative reference.

To make the values remain the same wherever you place them in the spreadsheet, you need
to make the reference absolute. Relative references change when you copy and move them,
and absolute references do not change.

To make a cell reference absolute, you need to place the $ symbol in the reference. Here is an
example of the difference between a relative reference and an absolute one.
Type of reference Formula example
Relative =C5+B5
Absolute =$C$5+$B$5
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The following steps show how to create an absolute reference:
1. Open the ‘Current clothing” worksheet.
2. Select B18, which should be the ‘Income’ total.

3. In the formula bar you will see =SUM(B5:B17). Click in between the
B and the 5. The formula will turn blue. Press the F4 key.

4. The formula will now read =SUM($B$5:B17). The B18 reference is
now absolute.

O
5. Repeat the absolute cell reference process with the C18, D18, E18 L

and F18 references.

Test your absolute reference creation by copying and pasting any of your absolute references to any
empty cell. The value of the absolute reference you choose should remain the same wherever it is placed.

Test, adjust and confirm formulas

It is important that the formulas used within a spreadsheet are appropriate for the data that
needs to be produced and that they can be tracked for errors.

This is where it is important that cell references are used. When cell references are used, it is
possible to trace calculation errors within a report.

Identify errors
Excel has many features to assist you in identifying errors.

First there is an alert that appears if there is an inconsistency in a formula. Look at the
following example:

~ B C D E F
n Monthly stock control
2
Product Quantity at Balance at end
3 |Product code description  startof month  Quantity in Quantity out of month
4 |PL123 Recycled White 209 50 65 194 Alerts that there is
5 PL344 Blue A4 paper 54 250 244' 60 a possible error in
6 |PL232 Green A4 paper 355 0 67 ( a5 the formula
7 PL987 Yellow A4 paper 12 250 214 48

If you select the cell with the alert and hold your pointer over the green triangle symbol that
appears, you will notice that a help bubble appears and explains the error that has been
identified by Excel.

D vl 48
%14 a8
The formula in this cell differs from the formulas in this area of the spreadsheet.

This helps you investigate and compare this formula to other similar formulas in the
spreadsheet to find out where the problem might lie and ultimately fix the error.

Once you have investigated the error, you can choose the option to ignore the warning if
there is no error. This will remove the green error flag from the spreadsheet.
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Formula auditing tools

Formula Auditing tools are located under the Formulas tab. They are useful when you are
investigating errors and working out how to fix them.

#io Trace Precedents (%] Show Formulas [_7
D':'E Trace Dependents “¥ Error Checking ~ o
Watch

v V5
1%, Remove Arrows ~ (/) Evaluate Formula ' \window

Formula Auditing

Of particular use is the Show Formulas tool, which changes the view so you can reveal or
hide all the formulas in the spreadsheet.

Another useful tool is the Trace Precedents tool, which shows where the data in the
calculations comes from. To use this tool, you first need to select the cell that contains the
error and then select Trace Precedents. The spreadsheet will show preceding connections,
as per the following example:

[pLaz2 Green A4 paper 355 0 @5 48

—_'_‘____’___,_,:——-—‘___,_,_,—‘—'—‘_‘ . AS
PL98T Yellow Adpaper e— 12 e— 250 & 214 48

Check calculations

As discussed earlier, it is important that you also undertake manual checks as necessary.
This means checking values against the original data, using a calculator to verify results and
discussing problems and calculations with colleagues and supervisors.

The case study in Practice task 6 shows how important it is to check your calculations. You
should also consult your supervisor or manager about the calculations and results your
spreadsheet has recorded.

Task requirements

Most organisations have developed policies and procedures for how reports are to be
presented. Paying attention to the presentation of your document will enhance the reader’s
ability to understand it.

It is also important to ensure that the contents of any reports you are producing are
accurate.

As part of the production process, it is necessary to check all information, including:
o names, addresses and phone numbers

« product information and pricing

o dates

« reference details (such as customer number, product code)

o spelling

« figures and calculations

o document-specific facts (such as summary totals, highlighted information for action or
review).
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Check information

If the information contained in the spreadsheet is
not accurate, it can cause problems for the company
that you represent. For example, you might work for
a retail outlet and be asked to keep a record of daily
sales. You might accidentally mistype Monday’s
daily sales as $43,000 when it should have been
$4,300. This would affect not only the spreadsheet
that you are preparing, but other financial reports
that determine profit and loss. This could then affect
other decisions that management may make; for
example, the number of staff required to work on a
particular day. ‘ \

Taking the time to check information and making
sure that it is correct helps to save time and improve
office efficiency. Checking information and report requirements with colleagues, supervisors
and managers assists in the preparation of reports that meet the organisation’s needs.

Practice task 6

1. Enter this data into a new worksheet, then complete the tasks that follow.

A B C D

1 Uanuary - sales commissions

2 |Name Total sales %ecommussion January commussion
3 |Mary §34,050.00 10%

4 Wilkam §29.881.00 13%

5 |Jarrod §9,837.00 10%

6 |Avdrer §19,884.00 12%

7 (Sam §12,098.00 12%

* Calculate the January commission using cell references; for example, =B3*C3 will calculate
Mary’s January commission.

* Using AutoSum, calculate the total of the January commissions.
* Using the MAX function, calculate the highest commission.

e Using the MIN function, calculate the lowest commission.

* Using the AVERAGE function, calculate the average commission.

¢ Save the file as ‘January sales commissions’.

continued ...
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... continued

2. Read this case study, then complete the tasks that follow.

Daisy works as an administrative assistant in a large office. One of her tasks is to create
spreadsheets. Her supervisor has asked her to create a spreadsheet with the cost price and
selling price of various products. Daisy then has to calculate the new price of stock after a 20
per cent discount. To calculate the discount of the value in B5, she uses =10%*B5. To calculate

the ‘Sale price’ to be shown in D5, she uses =SUM(B5:C5).

Daisy’s results look like this:

A C D

1

2 Sale Items

3

4 Product Code Selling Price Discount ‘Sale Price ‘
5 E343 $120.00 $12.00 $132.00
6 (1343 $140.00 $14.00 $154.00
7 G342 $150.00 $15.00 $164.00
8 |H988 $160.00 $16.00 $176.00
9 |H879 $100.00 $10.00 $110.00
10 | A232 $90.00 $9.00 $99.00
11 (M213 $30.00 $3.00 $33.00
12 |[N787 $125.00 $12.50' $137.50_

a) Explain the mistakes Daisy has made in her calculations for the ‘Discount’ and ‘Sale price’

columns.

b) What could be the consequences of the organisation using this data?

continued ...
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... continued

c) Rewrite the functions for the ‘Discount’ and ‘Sale price’ columns.

d) Describe what Daisy could have done to make sure her calculations were accurate.
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2 D Overcome problems with spreadsheet

design and production

You may need to access help when producing Excel spreadsheets. You may not understand
how an Excel function works or you may need help operating a printer.

Whatever the problem, you need to have a plan in place for dealing with the unexpected.
Organisations usually have a number of ways of dealing with software or hardware
problems. They may have manuals or training booklets for you to look at or they may have a
help desk for employees.

Here are some examples of possible problems.

Hardware

Your monitor stops working.

Software

Your software has been upgraded and you are unsure how to use it.

Formatting

You want to add borders and colour shading to your spreadsheet.

Layout

You want to change the orientation from portrait to landscape.

Formulas

You want to know why a formula seems to be giving the incorrect
answer.

Function
You want to know how to use the AVERAGE function.
Printing

You want to know how to print to the colour printer.

Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

63



BSBITU202
Create and use spreadsheets

Use Excel Help

If you are working in Excel, you can use the bl sl - "
Help facility “ . Full access to the Help facility G} A" | Search orline help £
requires you to be connected to the internet.

However, you can access standard Help facilities Need assistance?

without being online.
Use the search box to tell us what you're

To use Help, simply click on the Help facility and looking for and we'll do our best to find an
either use the chapter index or type a keyword e

about the information you need help with into
the Search bar.

You can also use F1 to access the Help facility.

Use tool buttons

Each time you move your mouse pointer over a tool button, _%v
it will display a Help bubble that tells you what the button
is used for.

i

== &3 Merc
[ Alignment

Font Color

For instance, from the Home tab, if you move your pointer

over the font tool the arrow is pointing to, you see this Help

message:

Change the color of your text,

0 Tell me more

Use manuals

Excel software comes with user manuals that
describe the software’s features and provide step-by-
step instructions for carrying out different functions.
You can find manuals in paper-based and online
formats. Look for paper-based manuals in your
organisation or your local library.

There are many websites where you can find
information about Microsoft Office applications.
These websites contain frequently asked questions
(FAQ) and solutions to common problems. You
can also download updates, tools and any fixes that
Microsoft has developed for software problems.

You may find the following websites useful:
http://support.microsoft.com

This is Microsoft’s main site for finding help to solve problems for all Microsoft products.
You can ask questions online and download files, including service packs, drivers and
patches. This site also gives you access to the Microsoft Knowledge Base, which offers help
for all aspects of problems that can be experienced when using Office 2013.

http://office.microsoft.com

This site provides resources for all Office applications. It has news and announcements and
useful files that you can download. If you are connected to the internet, you can open this
site by choosing Help and connecting to Office.com.
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Use training booklets

There are many ways to learn about computer functions and software packages. You may go
to a training course to learn a particular computer function or a supplier may instruct you
in the use of a piece of equipment. You may receive training when you start a new job.

Training courses usually provide a comprehensive set of instructions or notes that are worth
keeping for future reference.

Practice task 7

Read the case study, then answer the questions that follow.

Chinh works as an administrative assistant in a small manufacturing organisation. One of his
tasks is to create Excel spreadsheets for his supervisor.

When creating spreadsheets, Chinh often needs to use Excel Help to answer questions about
software functionality. If he is unsure of a screen icon’s function, he points to the icon with his
mouse and reads the Help bubble.

Recently Chinh attended a two-day Excel training course at a local community centre. He kept
the training booklet given out and stores it on his bookshelf. It has a handy index at the back
for quick solutions to problems. He has also photocopied pages from various manuals he has
found around the office and placed them in a Help folder on his desk.

Sometimes Chinh experiences software function problems that cannot be solved using Excel
Help. He then uses Microsoft’s support website to find a solution or refers to the paper-based
material he has gathered.

1. If Chinh experiences software functionality problems, where does he go for help?

2. Describe how Chinh uses paper-based manuals for help.

3. If you experience a software problem when creating a spreadsheet, describe the steps you
should take to solve the problem.
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Summary

Organisations use Excel spreadsheets to store and perform calculations on numerical
data.

You may need to adjust the height and width of columns and rows to suit the data.
Formulas and functions are used in Excel to perform calculations.

When using formulas and functions, you need to make sure that the result you get is the
result you want. Always test your calculations.

You can change the appearance of your spreadsheet to suit your organisation’s style and
presentation requirements.

Always check the data to make sure it is accurate and there are no spelling or
presentation errors.

To solve problems when producing a spreadsheet, make sure you have access to paper-
based or online help.

You can ask Excel for help at any time by pressing the F1 key.
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Learning checkpoint 2

Create simple spreadsheets

This learning checkpoint allows you to review your skills and knowledge in creating simple
spreadsheets.

Part A

Read this product documentation and product pricing worksheet, then answer the questions
that follow.

Product Code Price (before GST)
E334 1700.00
E343 1200.00
E788 1500.00
E708 1000.00
E356 8000.00
E376 2500.00

>
[o2]
m
Lw ]

1

2 Product Pricing

4 Product Code Price (before GST) 10% GST  Actual Price
5 E343 ‘ $1,700.00 $170.00 $1,530.00
6 |E334 | $1,200.00 $120.00  $1,080.00
7 |E708 _ $1,500.00 $15000 $1,350.00
g |E788 | $1,000.00 $100.00 $900.00
9 |E376 ‘ $8,000.00 $800.00 $7,_200.00 ‘
10 |E356 | $2,500.00 $250.00  $2,250.00
11

12 | _

13 Total Sales Tax = . $1,590.00
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1. Proofread the product pricing worksheet against the product documentation. What
major errors has the person entering the data into the worksheet made?

2. On the worksheet, the actual price of product E343 is given as $1,530.00. What is the
correct actual price of this product?

3. What is the correct GST for product E788?

4. What is the correct actual price for product E356?

5. Which value on the worksheet is correct?

6. Write a short paragraph describing the consequences of entering incorrect data. Give a
suggestion for how to prevent incorrect data being entered.
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Part B

Recreate the following spreadsheet.

Use Fill to enter the days of the week

Enter the values underneath the days

Format the labels to make data input easier

Add a border around the ‘Day Totals’ and the “Week Total’

Use the following example to help you. Use Excel Help facilities where necessary to
assist you in producing the spreadsheet.

A B C D E F

1 Monday Tuesday Wednesday  Thursday Friday
2 | 34 23 43 45 54
3 67 45 34 67 12
4 | 54 23 67 80 12
5 67 36 90 69 90
6 | 34 67 13 12 45
7 69 89 45 10 87
8 | 12 40 65 34 12
9 S0 32 10 60 23
10 | 23 S0 27 13 45
11 Day Totals [ ]
12

13 |Week Total I:I

Use a calculator to work out each of the daily totals. In B11, write a formula that
calculates Monday’s totals. Make sure your formula gives the same results as your
calculation.

Repeat this to add a day total for every day.

Use a calculator to add up all the daily totals. In B13, write a formula that calculates the
weekly total. Make sure your formula gives the same result as your calculation.

Print Preview your spreadsheet. Adjust the alignments of your labels and values until
you are satisfied with how your spreadsheet looks. Print out your spreadsheet.
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Part C

Recreate the following ‘Staff Salaries’ spreadsheet by entering the data into each cell. The
‘Hourly Rate’ is how much each person is paid per hour and the ‘Weekly Hours are how
many hours are worked per week. Use Excel Help facilities to assist you, as needed, to
produce the spreadsheet.

A B G D E F
1
2 Staff Salaries
4 Hourly Rate Weekly Hours Salary Salary Rise New Salary
5 |Joanne 25 40
& |Peter 20 35
7 Chong 24 40
2 Rose 28 30
9 Dylan 18 25
10 |Sienna 35 40
11 Dan 40 40
12 Brooke 25 35
13 Mark 23 25
14

15 |Total Salaries

o Format all the labels so they are Arial, Bold, 10. Add a pale colour to all the cells with
labels. Add a border to the cells ‘Staff Salaries’ and “Total Salaries’.

o Use a calculator to work out how much salary Joanne will receive. In D5, write a formula
that calculates Joanne’s salary. Make sure your formula gives the same results as your
calculation. Use Fill to add the values for the remaining salaries.

o All staff are going to receive a salary raise of 15 per cent per week. The ‘Salary Rise’
column is going to show 15 per cent of the values in the Salary column. Use a calculator
to work out 15 per cent of Joanne’s salary. In E5, write a formula that calculates 15
per cent of Joanne’s salary. Make sure your formula gives the same results as your
calculation. Use Fill to add the values for the remaining salaries.

o The ‘New Salary’ column is going to hold the value of the ‘Salary’ and ‘Salary Rise’
columns added together. Use a calculator to add up Joanne’s new salary. In F5, write a
formula that adds up Joanne’s new salary. Make sure your formula gives the same results
as your calculation. Use Fill to add the values for the remaining salaries.

o The value in B15 is going to contain all the ‘New Salary’ values. Using a calculator, add
up all the new salaries. In B15, write a function within a formula to add up all the ‘New
Salary’ values. Make sure your formula gives the same results as your calculation. Make
the cell reference of B15 absolute.

o Print Preview your spreadsheet. Adjust the alignments of your labels and values until
you are satisfied. Print out your spreadsheet.
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A chart is a graphical representation of selected worksheet information. Charts are used

to visually represent numerical data. It is usually easier to analyse columns and rows of
numerical data if they are displayed in a chart. Charts make it easy to spot trends, highlight
changes and compare figures over a period of time.

The best type of chart to use will depend on the type of data being converted into a chart;
for example, you might choose a pie chart to show one data series and a column chart

to show multiple data series. How you format a chart will depend on organisational and
task requirements. Formatting a chart enhances the presentation and readability of the
information.

In this topic you will learn how to:

3A  Select a chart type and design to enable valid representation of numerical data

3B Create charts

3C Use formatting features to modify the chart type and layout
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3 Select a chart type and design to enable

valid representation of numerical data

When producing charts, it is important to follow both
organisational and task requirements. An ~
organisation may have a set preference for the type of
charts it uses. For instance, it may prefer to use
column charts as opposed to line charts because it is
easier to analyse the information. An organisation
may also use certain colour codes for the
presentation of data; if this is the case, these rules
should be followed to ensure consistency of image.

Task requirements can depend on a set of
instructions and protocols in the production of
charts. You may be asked to prepare a summary
report of monthly sales as well as a chart. If this is

the case, you need to produce two documents. If the
policy is that a certain type of chart design is used for
the production of various reports, you need to do this.

If you have any suggestions for improving the readability and analysis of charts and their
associated data, discuss them with your supervisor or manager.

Chart types and their features

If you are using an Excel spreadsheet, you will be able to display your data in a chart. The
types of charts you can select include area, bar, column, pie, line and scatter.

Charts are visually appealing and make it easy to see data and recognise patterns and
trends. They make it easier to absorb information at a glance.

Example: chart

The following example shows the percentages of types of cakes sold in a bakery presented in a pie
chart. It is easier to look at the cake shop data in a chart, rather than in the columns and rows of a
worksheet.

TYPES OF CAKES SOLD

W Sponge
M Blackforest
m Cheesecake

= Carrot

Charts are linked to information contained in the selected cells. That means if the cell data is
updated (for example, the value 45 changes to 88), the chart is also updated accordingly.
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Choose and design a chart

The kind of chart you choose and its design should
reflect your organisation’s needs. In this section, you
will look at different types of charts and consider
some of their most appropriate uses.

Area chart

Area charts are used to demonstrate changes over
time. For instance, they may be used to show and
compare changes to sales over a given time. Area
charts highlight total values across a time line.

The following example shows how yearly real estate
sales figures vary for different outlets.

A | B | & | @& | & | F | 6 | W | 4 | 1 | K

1 Northcote Yarraville  GreensborouFootscray  Hamilton
2 2012 $303,002.00 $766,299.00 $736,252.00 $234,333.00 $345,222.00
3 2013 $451,909.00 $827,266.00 $627,262.00 $342,244.00 $423,234.00
4 2014 $568,218.00 $568,209.00 $743,662.00 $443,422.00 $342,344.00
5
j Chart Title
8 $2,500,000.00
9 $2,000,000.00
10
11 $1,500,000.00
12 51,000,00000 (N 2014
13 : m2013
14 $500,000.00 -
15

$0.00
16

O

17 o{@c
18 &
19
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Bar chart

A bar chart displays information as a series of horizontal bars. These charts are useful for
comparing data arranged in columns or rows. Bar charts show the differences between
individual items.

The following example shows how monthly sales vary for different departments of a
retail outlet.

Department sales for quarter

Sporting Women's Men's Children's

goods wear wear wear Cosmetics
January |$76,688.00 $45,466.00 $34,009.00 $68,087.00 $40,827.00
February 598,882.007 $45,628.00 $40,993.00 S_76,v529.00 $30,887.00
March $88,998.00 $34,778.00 $39,877.00‘ $87,652.00 $34,098.00

Department sales for quarter

Cosmetics

|| Children's wear

m March

Men?
en’s wear —
mlanuary
|| Women's wear
Sporting goods
50.00 $40,000.00 $80,000.00 $120,000.00

|
|
|
]
!
|
!
\

Stacked bar chart

Use a stacked bar chart to compare the values of individual totals to a total across categories.

The following example compares monthly department sales figures, as well as the total
overall amount.

Cosmetics

Children's wear

mJanuary

Men's wear
= February

m March
Women's wear

Sporting goods

$0.00 $80,000.00 $160,000.00 5240,000.00 $320,000.00
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Column chart

A column chart has vertical columns and is useful for comparing separate types of data
from a data series.

The following example shows how rainfall data can be used in a comparison.

Rainfall in millimetres
Melbourne Sydney

January 20 70
February 40 80
March 30 20
April 120 100
May S0 70
June 40 90

Rainfall in millimetres

140
120
100
80
60
40
-l 111 i
. ]
January February March April May June

m Rainfall in millimetres Mebourne m Rainfall in millimetres Sydney

3-D column chart

If you prefer the 3-D look for your column chart, choose 3-D when making your chart
selection.

Use a stacked column chart to compare the values of individual totals to a total across
categories.

The following example compares monthly rainfall for Melbourne and Sydney, as well as the
total overall amount.

Rainfall in millimetres

400

200
100

Melboume

Sydney

mlanuary mFebruary mMarch mAprii mMay mlune
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Pie chart

A pie chart shows a data series in percentage segments. It is useful for showing data as a
percentage of a whole. Pie charts are commonly used to show which products are selling or
how much market share an organisation enjoys.

The following example of a two-dimensional pie chart shows the market shares of five health
food companies.

Health First Fitness Foods Natural Organics Fruity
15 30 5 0 10

HEALTH FOOD COMPANIES

o Health First
o Fitness Foods
m Natural

m Organics

M Fruity

3-D pie chart

If you prefer the 3-D look for your pie chart, choose 3-D when making your chart selection.
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Line chart

A line chart shows the movement of values in a data series using single or multiple lines. It is
useful for showing how the values of a data series can change over a period of time.

The following example uses a line chart to show rainfall in Melbourne and Sydney.

Rainfall in millimetres

Melbourne Sydney
January 20 70
Fehruary 40 80
harch 30 20
April 120 100
May 90 70 Rainfall in millimetres
June 40 30 140
120
100
80
60
40
20
0

January February March April May June

v MEIDOUIME  wmgee Sydney

Scatter chart

A scatter chart is used to compare and arrange data to analyse the relationships of
information. A scatter chart displays clusters and is commonly used for statistical
comparisons.

The following example uses a scatter chart to display and analyse estimated sales and
actual sales.

Monthly sales targets

Estimated Actual
Jan-12 34000 35272
Feh-12 45000 38002
Mar-12 54000 65027
Apr-12 50000 65282

May-12 48000, 53899 MONTHLY SALES TARGETS

Jun-12 43000 42722
¢ Estimated @ Actual

70000

60000

50000 < S S
40000
30000
20000
10000

0
DEC-11 JAN-12 FEB-12 FEB-12 MAR-12 APR-12 APR-12 MAY-12 MAY-12 JUN-12

Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

77



BSBITU202
Create and use spreadsheets

Practice task 8

Read the scenario, then answer the question that follows.

Hemline Miller is a boutique fashion chain specialising in womenswear. Each outlet regularly
provides a monthly report on trade, including sales figures, customer numbers and quantity of
stock sold. Liza Guilano, the business owner, is happy with these reports. However, she realises
that some of the newer store managers are finding the information cumbersome to interpret.
Liza has decided that in addition to the reports, she would like to trial preparing the information
in chart form - a chart that compares the data for each of the outlets. She believes that a
graphical representation of the data will be easier for the managers to decipher and compare.

Liza asks you, the office manager, to prepare an example of how the data would be presented in
chart form. She asks you to use bright colours in the charts, as this complements the style and
colour range of the business. She also asks you to present the information in column form, with
values and stores identified in the chart. It is important that there is a heading on each of the
charts to clearly identify the information that is being reviewed.

What are the organisational and task requirements for producing the chart/s?
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3 B Create charts

Before you start to produce charts, become familiar with the terms used when referring to

parts of a chart.

The following information explains the meanings of terms you need to know.

Axes

An axis is a line that labels the
information in a chart according to
the labels in the columns and rows
of your spreadsheet. Axes (the
plural of axis) provide a reference
for measurement or comparison of
the data in the chart. Most charts
have a vertical axis (known as

the Y axis) and a horizontal axis
(known as the X axis).

Data range

The data range is the selection
of values you choose from a
worksheet to place in a chart; for
example, all the numbers in one
row or one column of data.

Produce a chart

Categories

Categories are the names that are
placed along the X axis of a chart
and are determined by the labels
in your spreadsheet.

Legend

The legend is the key used to
identify the various data series. If
you include the series labels from
your worksheet, Excel will add
these to the legend. Otherwise the
legend will display series 1, series
2 and so on.

To produce a chart, you must first enter data into a worksheet. You then need to select the
data you want to appear in the chart. Use the Insert tab and select the appropriate chart for
the data that you wish to present. A chart is linked to the worksheet it is created from, so if
you alter the data in the worksheet, the chart will be updated.

To produce the chart, choose the data that you want to present. Select the data by either
clicking and dragging over it with the mouse, or clicking on the cell to select it and then
using the Shift key and arrows on the keyboard to select the data.

The following example shows what selected data looks like.

A B C D E F
1 Northcote  Yarraville  Greensborou Footscray  Hamilton
2 2012 $303,002.00 $766,299.00 $736,252.00 $234,333.00 $345,222.00
3 2013 $451,909.00 $827,266.00 $627,262.00 $342,244.00 $423,234.00
4

2014

$568,218.00 $568,209.00

$743,662.00 $443,422.00 $342,344.00]
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Example: choose and produce a chart

The type of chart you choose will depend on your organisational requirements.
The following steps show how to produce a column chart.
1. Open Excel and enter the following data into a worksheet. Save the worksheet as ‘Company cars’.

A B C D E

1 1

2 Company Cars

4 Make  Melbourne Perth  Sydney Adelaide
5 |Ford . 3 3 2] .
& |Holden B 5 1 6
7 |BMW 1 4 5 1
8 Audi. 1 3 4 3
9 |Mazda 5 3 6 a

2. Select cells A4 to EQ. This selection should cover all the labels and values. This selection has now
become your data range. Do not include any blank rows or columns in your selected cell range.

7
e

7

8

3. From the Insert tab, select the appropriate chart you wish to display; for example, ‘Column’.

BE=-%- s |

2-D Column

af A

af g
il

lid More Column Charts..,

continued ...
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... continued

4. The chart will now display as an object in your spreadsheet.
A | B | € | D | E | F | 6 | H | I | 3 | ¥

Company Cars

hMake Melbourne Perth Sydney Adelaide
Ford 3
Holden
BRAW
Audi
Mazda

W 0~ o U s W
Ui PN
- AT R e R X T

W W s w

[ i
N R o

Company Cars

| Audi

Ford Holden BMW Mazda

[ o S S S R S R ST
S W W~ o Ul s W
Noow B o~

n
—
[

o oS
w w N

Ll
o=

m Melboume mPerth mSydney mAdelaide

5. To move the chart to a separate sheet within the workbook, select Move Chart from the
Design tab. A dialog box will appear; select to place the chart in a new sheet 2"}::
and then name it appropriately (for example, ‘Cars by state’).

Location
6. The chart will now have a separate sheet in the workbook. If you look at the worksheet names,
you will notice that the chart now appears there.

1

| Sheetl | Sheet2 | Cars by state | Sheetd | *

7. If the data you want to include in a chart is not in adjacent rows and columns, use the Ctrl key to
make multiple selections in different locations on your worksheet.

8. Trendlines can be added by selecting the Trendline tool from the Layout tab in Chart tools.
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Practice task 9

Create this spreadsheet data for Hemline Miller that shows sales, customer numbers and quantities
sold. Save the document as ‘Hemline Miller January report’.

Hemline Miller
January report

Customer Quantity

Store Sales numbers sold
Chadstone 78009 567 1298
Bundoora 95080 892 2098
Wangaratic 120708 927 1792
Seymour 110920 828 1777
Newport 102787 998 2143

1. Create a column chart that compares the sales data.
2. Create a scatter chart that compares customer numbers with quantity sold.
3. Create pie charts for sales, customer numbers and quantity sold.

82
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Use formatting features to modify

the chart type and layout

After you insert a chart into your worksheet, you will notice that two new tabs appear when
you click the chart: Design and Format. The Layout tools also appear next to the chart.

CHART TOOLS
DESIGN FORMAT

Chart tools

Design tools enable you to change the type of chart selected, choose the style and layout,
alternate the view of data between row or column, and check or adjust the data selected.

o o ot
"= oo elle ZEn®
AdaChan Quek  Change S— | SemchRaw/ Seea  Change  Move
Bemant » Layost ~  Colon Colemn  Osta  QwatType Chan

Chart Layoutts Onant Stypdey Data e Lecation

Formatting tools enable you to alter the general appearance of the chart such as colour, font
type and font size.

B o psier pAGRLAYOUT  FORMUAS  DATA  RVEW VW ACROBAT  DRSCN  FORMMT

< S 3 [ 5 .
c.MnAau BN N ,..'9‘““, : & Algrn $lira2em :
53 Forman Selacton 100+ ux| e s | [ [Z Shape Dutline » A A M ) 2 ‘ :
D ResttoMatchinte 04 L L¥ > = ¥ Shape Hecty v B Selection Pane LRty - weeddTem

Camvent Salezon e age Lrape e % Waczhn o % Arange tas

The data table is the data contained in the spreadsheet that the chart draws its
information from.

Layout tools enable you to add to and adjust the appearance of the chart by adding titles,
labels, gridlines and so forth.

[+

[+]
e

. CHART ELEMENTS - STYLE  COLOR . VALUES; | NAMES
T A p— = o 4 SERIES &]
{"“5 Axis Titles [J T — [V (Select All
= Chart Title ;E ‘ B A
‘I;l Data Labels S .I .' .ll [ § Devid
S E::;:’:e tiwa ~:‘:ﬂ_ HEE :: :._.. i V] B Esther
Gridlines AT = a0 S GTTiNG [/l B Gowrie
Legend e T B S [v] B Helen
[] Trendiine , } 2§ Lee
| |I|| I ¥ B Malcolm
o sl ¥l B Shari
IANUARY - BIRD SPOTTING \;;] Trudi ]
E..A.:.. Bt e s e e
§ 4 CATEGORIES
v l@‘ Select Data...
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Why format your chart?

You need to format your chart depending on the
organisational and/or task requirements. Formatting
the chart can also enhance the presentation and
overall readability of the information.

Balance the time taken to prepare the chart with the
required output medium. For example, if you do not
have a colour printer or are not presenting the charts
electronically, it is not necessary to spend a lot of
time selecting colours. You only need to ensure the
font type and size are appropriate and the chart is
well presented.

All parts of the chart are separate components and
can be formatted and adjusted as appropriate. To
select part of the chart, point and click to select it
and then use the tool bar or right-click mouse shortcut menus to make appropriate changes.
Formatting of the chart can relate to colour choice, using gridlines, adding borders, adding
titles and labels, font size and type, and even changing the choice of chart type to be used.

Titles in a chart are separate objects and can be moved around and resized by clicking and
dragging with your mouse.

Once you have created a chart, you need to format it to suit your organisational requirements. This
may include formatting the data range, text and legend, or adding a pattern to the chart area.

The following steps show how to format a chart.
1. Open the ‘Company cars’ chart.

2. Click inside any of the Adelaide data series columns. Right-click your mouse and select Format
Data Series. You will see the following Format Data Series dialog box:

Format Data Series v X

SERIES OPTIONS ¥
ISRy |

4 SERIES OPTIONS
Plot Series On

® Primary Axis
Secondary Axis
Series Overlap - -27% :]
Gap Width —i 219%

continued ...
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... continued

3.

10.

11.

12.

Click Fill and select Gradient fill, then choose a preset colour and click on Close. You will notice
that the Adelaide data now has a shade effect in the chart. If you want to change the look to
something different, select Picture or Texture fill instead, then select an appropriate texture.

Repeat this process to choose Gradient fills for the Melbourne, Perth and Sydney columns.

The Plot Area is the space behind the columns. Right-click in the Plot Area and select Format
Plot Area. The Format Plot Area dialog box will appear. From Fill, select Solid Fill and choose an
appropriate colour. Click Close.

. The Chart Area is the space behind the legend and the chart labels. Right-click in the Chart Area

and select Format Chart Area. The Format Chart Area dialog box will appear. From Fill, select
Solid Fill and choose an appropriate colour. Click Close.

To add a border to the Chart Area, right-click and select Format Chart Area. From the Format
Chart Area dialog box, select Border colour, choose Solid Line and make the colour black. Click
Close.

. To add a chart title, select Chart Title and then Above Chart from the Layout options. Type

‘Company cars’ in the text box.

[

N T E N

W (< CHART ELEMENTS Series Overla
p % Axes Gap Width
&~ Axis Titles
J
: /
‘Y [Z] Chart Title | 2 < | Above Chart
Data Labels
% Da : Ta ble Centered Overlay
ata lable
[] Error Bars More Options..,
[Zl Gridlines
[v] Legend
D Trendline

To add axis titles to the chart, select Axis Titles from the Layout options and add a horizontal
title (‘Make of car’) and vertical title (‘Number of cars’).

To format the text in the chart title, select the Chart Title and use the formatting tools on the
Home tab. Format the title to be Arial, Bold, 16. Format the labels of the axes (‘Make of car’ and
‘Number of cars’) to be Arial, Bold, 12. Format the legend to be Arial, Bold, 10.

To add data labels to the chart, select Data Labels from the Layout options, then select an
appropriate position in the chart (such as centre). This example displays the number of cars for
each model on each data range.

Format gridlines in the chart by right-clicking and selecting Format Major Gridlines. Select Line
Style and choose a dashed line style. Click Close.

continued ...
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... continued

13. The chart should appear similar to the following example:

Company Cars

N 7
u
m ° .
b g
e 5
r 4
2 l
: TRN. HENN
e Ford Holden Audi Mazda
Makeofcar

= Melbourne wPerth = Sydney = Adelaide

Practice task 10

Open your document ‘Hemline Miller January report’. Format the charts (using bright colours,
gradients and textures) to include relevant titles and labels as follows:

1. Column chart - include the title ‘January - sales’.
2. Scatter chart - include the title January - customer numbers vs quantity sold’.

3. Pie charts - include relevant titles for sales, customer numbers and quantity sold, as well as data
labels showing percentages of the total.

Unit release 1 (Aspire Version 1.1)

86 © Aspire Training & Consulting



Topic3
Produce simple charts

Summary

1. A chartis a graphical representation of selected spreadsheet data.

2. Charts are visually appealing and make it easy to display comparisons, patterns and
trends in data.

3. The type of chart you choose to display data will depend on organisational and task
requirements.

4. When you insert a chart into an Excel worksheet, two new tabs appear — Design and
Format. The Layout options also become available.

5. Each component of a chart can be formatted and adjusted individually as needed.

6. Inaworkbook, a chart can appear either as an object in a worksheet or in a separate
worksheet.
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Learning checkpoint 3

Produce simple charts

This learning checkpoint allows you to review your skills and knowledge in producing
simple charts.

Part A

Explain the type of data most suited to each of these chart types:
1. Pie

2. Column

3. Stacked bar

4. Line

Part B

Produce a chart that suits your organisation’s needs. Talk to your supervisor to identify any
existing data, or data that you could enter, to create a chart. If it is not possible for you to
use data from your organisation, complete the following activity based on information from
past employment or from your life experiences; for example, a budget or savings plan.

o Choose a chart type that best suits the data you have entered. Create the chart.

o Format each part of the data range with a different colour. Add a gradient, texture or
pattern to each data series.

o Format the title and legend to increase their readability.
« Print out your chart.
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Part C
Read the following data and complete the tasks that follow.
A B C D

1 {
2 |National Sales Figures
4 | 2013 2014 2015
S .Sydney 23,000 15,000 40,000
6 ‘ Perth 35,000 13,000 25,000
7 |Meibourne 12,000 25,000 30,000
8 'Brisbane 45,000 30,000 50,000
9 |Adelaide 10,000 15,000 20,000

o Choose a chart that best suits this data. Create the chart.
« Save the worksheet as ‘Sales figures’ and store it in an appropriate place.

o Format each of the data ranges with a new colour. Add a gradient, texture or pattern to
each data series.

o Format the title and legend to increase readability.

« Print out your ‘Sales figures’ chart.
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In the workplace, it is important to produce quality spreadsheets and charts that adhere to
organisational and task requirements. Make sure that the final spreadsheet and chart have
been thoroughly checked and proofread before sending or presenting them, so the correct
message and company image are delivered to the appropriate person/s.

For example, if you have not spellchecked a document and it contains errors, or if you use
an old product code, this sends a message to the receiver of the information. They may think
that you, and the company or department, do not really care about the matter contained in
the report.

In this topic you will learn how to:

4A Preview, adjust and print spreadsheets and accompanying charts

4B  Ensure data input meets time lines and requirements for speed and accuracy

4C Name and store a spreadsheet, and exit an application safely
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4 Preview, adjust and print spreadsheets

and accompanying charts

When preparing spreadsheets and charts, it is
important that you adhere to the required time lines
and job instructions. If you believe that there needs
to be alterations to either the time line or job
instructions, you need to discuss this with your
supervisor and/or the person who has requested

the work.

Many businesses have strict deadlines for completing
tasks — it may be that your manager needs a financial
report for a weekly meeting. Failing to meet the
deadline and provide the required information may
affect other tasks.

Many spreadsheets need to be accessed by other
people in your work team, so ensuring that you save
files appropriately will save time and improve office efficiency. Accessing spreadsheets is
made easier by using appropriate file referencing and saving options.

Save files to the correct drive (for example, the network drive), the appropriate folder (for
example, your department name) and appropriate sub-folders (for example, project name)
and assign a file name that is relevant to the file (for example, ‘Sales report March 2016’).

Print your worksheet

Once you have created a workbook or spreadsheet, you will probably need to print it. Before
printing, you need to make sure you have undertaken a number of checks.

First, make sure you have adhered to and met all organisational and task requirements for
completing the spreadsheet. This incorporates instructions for information to be included,
as well as formatting and layout of information. Proofread your spreadsheet and check

all formulas and functions before printing. If needed, make appropriate adjustments to
the data.

Many organisations follow a policy that spreadsheets are previewed and checked on-screen
prior to printing. Even if this is not the current policy in your workplace, it is a good
practice to include in your routine work processes.

It is also important that you do a Print Preview of the data prior to printing, as this can save
time and improve efficiency. It reduces paper wastage and allows you to undertake a check
of the data - ensuring accuracy of information and presentation.
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The following steps show how to preview your work in Excel.
1. To preview your spreadsheet or chart, select the File tab , then Print.

2. The preview of the job will appear to the right of your screen and look similar to the following
example:

Chagtied - 30 Foe chae Bl

L T Syt G g
rearibex  foam fmxe Mmam Dpna ey
- . . - -
Printer

P Dorter om eoan] B Vst Focd Cuanjamber

o
T o

1o Cmpportras
Settings
f e Active Sheets >
i

Ay TS B s Shers

Pages HE v ot et e s 1 el e o g

T peee Dre Sae B DA
Oy pred e orm Se ot W

(9 Colmnd

s 12 1
Pormmt Oriertatins -
A2 000« 20wy
B ewa

L e
o 108 em R LIV e

Be careful when selecting multiple worksheets. If you have a number of worksheets active at

one time, any data that you alter and input will be repeated on all of the selected worksheets. To
deactivate multiple selected worksheets, simply click on one worksheet name. This will then become
the active worksheet.
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Example: print a worksheet

The following steps show how to print a worksheet.
1. Open the document ‘Current clothing’.

2. From the File tab, select Print. The
worksheet will be displayed exactly as it will

be printed. B r—
. O Copies: Ll -
3. Under Settings, select Landscape i=a

orientation and scaling of 135%. (Scaling Pt

allows you to adjust the size of the printout Save

and make it larger or smaller on the printed ;

page ) Save As Prlnter

. i : 3 @ Pubs_Printer on atcservl
4. Use the Settings to alter this from all pages ;;V; asAdobe < Resdy

in the document to only selected pages. Printer Properties

Alter the printer you are using if necessary, Print Setti

then select how many copies you want to BRNGS

. . . Share 7 Print Selected Chart
print. It is also possible to choose whether i -
. . . . Only print the selected chart

the multiple printed copies are collated. Click Eort N =

Print. Piges | > =
Close Print One Sided -
. Only print on one side of th...

== Collated

Account |[—!E]|E 123 123 123 i

Letter (8.5x11")
2159 cmx 2794 cm

Portrait Orientation -
Options

H’ Normal Margins -
Left 1.78 cm Right: 1.78 cm

Page Setup

Example: print a selection from a worksheet
You may be dealing with a very large worksheet or your manager Month  Income
may have requested only some information from a worksheet. January $5,000.00
. . . February $43,543.00
If this occurs, you may need to print part of a worksheet: March Y ann00
1. Open the ‘Current clothing’ worksheet. April $4,500.00
2. Sel lls A4 to B18. This should Il the ‘Month’ and Mey o
. Select cells A4 to . This should cover all the ‘Month’ an Forie 000,00
‘Income’ data. Juty $43,543.00
3. From the File tab, select Print. August $3,454.00
September $3,453.00
4. From Settings, select the first drop-down menu and Print October $32,552.00
Selection. November $39,800.00
5. Click Print. Deeemieell 0000
Totals $272,799.00
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Print a workbook

To print an entire workbook comprising multiple worksheets, follow the instructions for
printing a worksheet, but in Print select Print Entire Workbook.

Example: print a chart

The following steps show how to print a chart.
1. Open the document ‘Company cars’.

2. Select the chart by clicking on it. Because
this has been selected, only the chart will be

Print

previewed and not the data in the spreadsheet. = Copees: [1 g
3. From the File tab, select Print. Your chart will B
be displayed exactly as it will be printed. Under oot
the Margins drop-down menu, manually adjust :
the left and right margins by selecting Custom Printer
M argi ns. @/ Pubs_Printer on atcservl
-2, Heady
4. Alter the printer that you are printing to if Printer Dropertie
necessary, then select how many copies of the Settings
chart you want to print. Click Print. vy T
':'"I Only prind the selected chad
Pages: - to -
You can adjust the size of the printout by altering ™= Print One Sided

Only pring an one side of th

‘Adjust to’ to more than 100% of normal size in the

Page Setup dialog box available from Print. &l Collated

’ 123 123 123

Portras Onentation -

Options

9 Letter B5x117)
- 59 cma 2794 ¢cm
Narmal Marging
Left: 1L7Bem Raghtt 178 ¢m

-

Page Setup

Practice task 11

1. Open your document ‘Company cars’.

* Preview the spreadsheet. Check the appearance of the data and chart, and make any
necessary adjustments prior to printing.

* Print one copy of the spreadsheet.
* Close the file.
2. Open your document ‘Company cars’.
e Select cells A4:B9; this will select only the make of the cars and Melbourne data.
* Print only the selected data.
e Close the file.
3. Open your document ‘Company cars’.
e Select the chart only.
* Print the chart.
* Close the file.

4. From your ‘Current clothing’ worksheet, print out the ‘Profit’, ‘Tax’ and ‘End profit’ columns,
including the ‘Totals’. Adjust the size of your selection until it is 150 per cent of its normal size.
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4 Ensure data input meets time lines and

requirements for speed and accuracy

Whenever you are given a work task, you need to plan
a time line, which is a plan for how long it will take to
complete a task. It also breaks the task into steps and

details when each step must be completed. —/\/ = %’

Time lines will normally be pre-designated and
depend on instructions given or dates when
tasks need to be done by. This means that work
you are completing needs to be finished within a
specified time.

|||”:. En"'l :

You may have to create a spreadsheet to your
manager’s specifications, which may include a
deadline. The spreadsheet may be needed for a board
or client meeting and if it is not ready on time, it will
not be useful.

Find out when the spreadsheet is required and enter the date in your diary. Identify and
plan the task requirements to work out how long it is likely to take. Careful planning means
there will be no last-minute panic.

If you are developing a spreadsheet for someone else, always clarify exactly what is required;
for example, are formulas needed and do you have to create a new column? If you have to
write formulas, make sure you allow enough time to have them checked by your manager.

Time lines

Preparing a checklist can help you plan a work task. Creating spreadsheets will become
easier once you are familiar with your organisation’s requirements.

Look at the following example of a checklist.

Create a Thursday | Enter product data. v
spreadsheet | 17 March | pyoofread the data.

for the ) o

manager Format the spreadsheet using the organisation’s style

guide.

Create a new column named ‘Discount’.

Write a formula to calculate 10% of customers’
balances.

Create a column named ‘Sale price’.

Write a formula to calculate the new sale price.
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Enhance speed and accuracy

When producing reports and charts in Excel, it

is important that you undertake tasks in a timely
and efficient manner. Keeping to time lines is one
aspect; another is using the software appropriately
and efficiently to save time and ensure the accuracy
of data.

Use shortcut menus (right-click mouse button) to
bring up quick commands for undertaking actions.
Use shortcut keys to undertake actions quickly (for
example, Ctrl X to cut, Ctrl V to paste). Familiarise
yourself with the tools available in the ribbons and
the groups of tools under each tab. If you think
there should be an easier way of doing something,
there probably is. Search the Excel Help facility for
assistance.

Use the numeric keypad on your keyboard for data entry of values. Although Excel is
mainly used for entry of numbers, learning to improve your typing speed and accuracy can
help. Learning to touch-type may be a way to improve your typing speed.

Organisational time lines

In a workplace, you will often be required to meet specific deadlines. Your supervisor may
tell you what the deadline is for completing set tasks (for example, prepare a draft summary
report by 2.00 pm) or you may have regular deadlines for common tasks (for example, on a
monthly basis, create a report of customers whose invoices are unpaid and overdue) or there
may be financial requirements (for example, a summary report of GST costs). It is important
to adhere to organisational time lines for the efficient running of the business.

If for some reason a deadline may not be met or you have conflicting work priorities, discuss
this with your supervisor. However, do not leave it until the last minute. Your supervisor
may be able to help you by making suggestions about how the deadline can be met or they
may be willing to adjust the deadline.

Using a diary system and a to-do list can help you prioritise tasks and be aware of the time
lines required for set tasks.

Time lines agreed with an internal or external client

Most organisations have a range of clients, who are either internal or external. Internal
clients are those who work in the same organisation, such as work colleagues, people in
other departments, managers and supervisors. External clients are those who are outside the
organisation, such as customers and suppliers.

In many cases, time lines are set and agreed with your clients, both internal and external. If
you agree to a deadline for completing a task, it is important that you meet it and if you can’t,
speak to your supervisor and the client. Your supervisor may be able to make suggestions that
you have not thought of to help you meet the deadline. Speaking with your client will allow
you to discuss the issue/s with them and may help you to adjust the deadline.

Meeting a deadline demonstrates your competence in undertaking tasks; it also shows
professionalism on the job. When deadlines are being set, be sure that they are both
achievable and realistic.
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Time lines agreed with a supervisor or the person requiring the
spreadsheet

In many cases, the time line for the completion of

a task is set by your supervisor or another person.
They may have certain deadlines to meet as well and
this is why they are setting a certain time frame for
the completion of the task that they have requested
from you.

If you are asked to complete a task, always ask

what the deadline is. If you have a high workload

at present, ask them if the deadline that they have
specified is definite or if it is able to be negotiated.

In many cases, there will be room for negotiation.

If it cannot be negotiated, explain your conflicting
priorities or discuss them with your supervisor, and
try to work out a happy medium or see if you can get
additional assistance so you can meet your other deadlines. Your supervisor may be able to
pass some of your other work on to another colleague to complete.

Always ensure that the time line set is realistic and achievable, and that if there are any
problems, you discuss them with your supervisor and/or the person who requires the
spreadsheet.

Practice task 12

Read the case study, then answer the questions that follow.
Case study

Charles works as a personal assistant to a manager in a large organisation. One of his tasks
is to create spreadsheets. Charles is asked to create a spreadsheet with information about
products. He is given a lot of information about the products including their codes, their prices
and how many had been sold over the last financial year.

Charles clarifies with his manager the exact information that is needed. He finds out that his
manager wants to know how much every product costs in order to calculate a 10 per cent
discount off all stock for a stocktake sale. His manager also wants to know how much the
products would cost with the discount. Charles is given two days to produce the spreadsheet.

Charles selects the information that is needed in the spreadsheet. He breaks the task into
parts and creates a checklist for every task that needs to be done and when it should be
completed. He then writes a formula to calculate 10 per cent of the products’ prices and a
formula to work out the new prices of the products. He tests his formula and shows it to his
manager.

continued ...
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... continued

1. How did Charles decide what information was needed in the spreadsheet?

2. How did Charles organise his tasks so that he could manage his time effectively?

3. Imagine you are Charles. What columns of information would you place in your spreadsheet to
produce the results your manager wants?

4. Write a short paragraph explaining why using a checklist can help you produce a spreadsheet on
time.
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4 Name and store a spreadsheet,

and exit an application safely

Information is a valuable asset in any organisation.
How information is stored and the security measures
used to protect it are central to an organisation’s
procedures.

The spreadsheets you create will usually be stored on
a server that allows access by multiple users. A server
is a computer that delivers information and software
to other computers linked by a network.

To enable staft to log onto a server, the systems
administrator issues each user with a username. The
user must then create a password. Usernames and
passwords:

» give users access to the information they require
to complete workplace tasks

o allow users to have different levels of access to information.

You may find that some of the spreadsheets you work with are confidential. Ask your
manager for your organisation’s policies regarding confidential material.

Document loss

Data also needs to be safeguarded against accidental or deliberate damage. Data loss is
usually caused by human error or system failure. Many organisations use a data cartridge
at the end of the day to back up the information on the database. This cartridge can then
be taken oft-site for safety. If any damage occurs to the server or the premises, a complete
information backup is available.

A server is made up of lots of files and folders. Organising this information helps users find
what they want. If you are saving information onto a server, make sure you know where to
put it. Find out your organisation’s policies regarding the storage and security of Excel files.

Create a spreadsheet to be used by previous versions
of Excel

Microsoft Excel 2013 has many advanced features that are not available in previous versions.
If you are creating a spreadsheet that is to be accessed electronically by people with older
versions of Excel, you will need to work in Compatibility Mode, which turns off some of

the newer, more advanced features and ensures that those working in older versions (for
example, 2003) will still have full editing capabilities.

To create a spreadsheet in Compatibility Mode, select the File tab, select Save as and select
Excel 97-2003 Workbook in the Save As Type list.

In the file name box, type a name for your spreadsheet and click Save. It is important that
this is done when you are starting to create a spreadsheet.
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Name, store and close spreadsheets

When producing spreadsheets, you need to be aware
of how to name them and where to store them.

All organisations have policies and procedures for
naming and storing spreadsheets. Ask your manager
to explain your organisation’s requirements.

Files can be stored in soft or hard copy. This means
that they can be stored electronically in a computer
or in a paper-based form in a filing cabinet.

M

misfiled or accidentally disposed of. Storing many reports can also be expensive and some
organisations prefer to store information digitally. Digital storage saves on paper and space.

Hard and soft copy storage

Paper reports can become damaged, yellowed and
brittle. Also, unless you are very careful about
storage and use, important reports can be easily torn,

Another advantage to storing reports digitally is that powerful databases can be used to
search the stored information. Databases enable you to find specific information that would
be much harder to find by searching through hard copies of reports.

Databases also provide management with powerful metrics and reporting tools. For
example, statistical information can be gathered from a database and detailed reports
produced.

Folder structure and naming standards

Folder structure and naming standards are needed to allow staft to set up folders quickly
and easily. Shared directories are folders on a network that a group of people have access to.

If you use shared directories, you need to assess whether an electronic file should be placed
in the shared directory or stay on your own computer’s hard drive. Decide which reports are
for your use and which need to be shared.

Advantages of using shared directories and naming standards

* |t can prevent the loss or misfiling of electronic documents.
* Work is less likely to be duplicated.
* It makes it easier to share information between colleagues.

* Reports on the same or related subjects are located together, which helps
people find and retrieve files.
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Example: shared directory

To set up a shared directory, you must first allocate a shared network drive. Your IT coordinator can
help with this.

The first place to organise a directory is at the folder level. Folders have a tree-like structure that
branches from a parent directory to sub-folders in a hierarchical structure.

The following example shows the structure of a shared directory.

SERVER (C drive)
——— Group A
— Group B
e Growp C
Procedures
" Personnel
L Projects
——— Projedt A
- ProjectB
Project C

| ProjectC_time lines.xksx

ProjectC_researchl xdax

In this structure, the server has three folders for three separate work groups: Group A, Group B and
Group C. Group C has three major folders: Procedures, Personnel and Projects. The Projects folder
includes: Project A, Project B and Project C. Project C has two spreadsheets: ProjectC_time lines.xlIsx
and ProjectC_researchl.xlsx.

The file path for retrieving a file starts at the server and ends when the correct file is located. For
example, to reach ProjectC_time lines.xlIsx, the file path to follow is
C:\Group C\Projects\Project C\ProjectC_time lines.xIsx.

In Microsoft Excel 2013, the spreadsheet extension is .xlIsx.
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Document properties

As well as using user-friendly naming
and saving conventions and adhering
to organisational requirements, it can
be useful to use document properties

to record common information

about a file.

Document properties assist in
describing or identifying a file and
include details such as title, author
name, subject and keywords that state
the spreadsheet’s topic or content. The
information contained in document
properties can also be used when
conducting a search for files on your
computer.

Versions

Browser View Opticns

To set document properties, select the
File tab and select Info.

Back up files

Many organisations have set procedures for backing up files. In many large organisations,
this is administered through the IT department and is an automatic process. In this case,
the only thing you need to make sure you have done is to save your files to the appropriate
network drives and folders.

In smaller organisations, it may be necessary for you to back up files yourself - this may be
done on a daily or weekly basis. It may require you to back up files to another disk drive. If
this is the case, check with your supervisor for procedures for backing up.

Backing up files is an important protocol. It helps prevent the loss of documents and
information, and is extremely useful when something happens to the network or
computer system.

Most folders and files are stored on servers and are backed up using external disk drives or
data cartridges. Information from an entire server can be saved onto an external drive and
stored in a safe location.

The organisation should regularly delete old electronic files and folders to ensure an efficient
use of server space. Always ask for authorisation before making any deletions.

USB memory sticks are also useful for storing and backing up information, especially when
you require a portable copy of the information.

Hard-copy storage

It is common for spreadsheets that are stored digitally to also be stored in hard copy. This
safeguards against a computer system failure. Hard-copy storage requires space and a filing
system that uses consistent, simple and meaningful names similar to digital storage.
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Hard-copy spreadsheets must be kept up to date. It is necessary to manage hard-copy
spreadsheets, as storage space in organisations is often scarce and valuable. Old or
superseded spreadsheets must be destroyed on a regular basis. Retention schedules list the
time frame spreadsheets need to be kept for before they can be destroyed. Spreadsheets
without permanent value may be scheduled for eventual destruction.

Find out what kind of hard-copy filing system is used in your workplace or place of study.

Close applications

After creating or modifying an electronic spreadsheet, you need to exit the software
application without causing damage or loss to the data. Data loss occurs when a computer
program stops performing its expected function. Often the program or even the whole
computer may appear to freeze.

All computer users will experience data loss at
some time and will be unable to access their data,
which can be accidentally erased or corrupted and
made inaccessible. The main cause of data loss is
human error.

There are precautions you can take to prevent data
loss. Try to work on only one spreadsheet at a time.

Data loss can also occur if someone else tampers with
your work. If you are working on a spreadsheet at
your workstation, you need to lock your computer or
exit the application before leaving your workstation
unattended.

Use multiple applications

If you need to work with multiple applications open, make sure you close applications that
are no longer needed. This will help your computer work more quickly and will prevent data
loss in the event of computer failure.

Other causes of data loss include virus damage, operating system or application software
bugs, and failed upgrades.

Another precaution against data loss is to be on your guard with your computer. For
example, if your computer starts to make unusual noises, shut it down immediately and do
not turn it back on until you have received advice from an IT coordinator.

To exit the program, select the exit button , which is located in the top right corner of
the window. If you have recently made changes to your spreadsheet, you will be prompted to
save these changes.
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Practice task 13

Read the case studies, then answer the questions that follow.

Matthew works as an office administrator in a large organisation. His duties include formatting
reports and saving them on the server. He is also responsible for backing up the server at the
end of each day. At the end of a busy day, Matthew had completed several reports for different
departments within the organisation. He had to save each of them in a different location,

and it took him a while to work out where they all belonged. He wasn’t sure if he had saved
them all in the correct place. After this, he was running late and decided not to back up the
server. The next morning, the reports that Matthew had saved were needed for an important
board meeting. However, during the night a virus had infected the server, destroying all the
information from the previous day.

Fred has retired from an organisation after working as an administrative assistant for 10 years.
The areas Fred was responsible for were accounts and projects. The day after he retired,
someone needed a file that Fred had created and stored. The file contained vital accounting
information. It was discovered that Fred had saved more than 500 files in a variety of folders
and the file could not be located. The folders had ambiguous names such as Folderl and
Folder2 and the files had names such as augustl.doc and march2.doc.

1. What would be the consequences if Matthew did not save some of the reports in the correct
place?

2. Can you think of any consequences of not backing up data on the server?

3. Describe why Fred’s folder and file naming system failed.

continued ...
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... continued

4. Fred was responsible for two areas. What could he have done to make sure files could be easily
located?

5. Explain why folder and file names should be consistent, simple and meaningful.

Summary

1. Producing a spreadsheet means creating it and having it ready for viewing by your
colleagues or manager.

2. Working within a designated time line means you must plan your work.

3. Make sure you have formatted, checked all formulas and functions, and proofread your
spreadsheet before printing it.

4. Ttis possible to print a whole spreadsheet or parts of a spreadsheet, depending on what is
required.

5. A chart can be printed on its own or as part of a worksheet.

6. You need to understand your organisation’s policies and procedures about saving and
storing spreadsheets.
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Learning checkpoint 4

Finalise spreadsheets

This learning checkpoint allows you to review your skills and knowledge in finalising
spreadsheets.

Part A

Read the case study, then complete the tasks that follow. Use shortcut keys and menus to
assist in maximising the efficiency of the software.

Mario works as a personal assistant for a manager in a large organisation. His manager
asks him to produce a spreadsheet of customer information. The spreadsheet must list 200
customers and their accounts. It must also calculate a 10 per cent interest charge on the
accounts and display customers’ new balances. The spreadsheet needs to be ready in two
days. The following table lists five customers that Mario has to enter:

Customers Balances
Sanchez $2,300.00
McGregor $4,000.00
Cunningham $5,000.00
Wijerwadene $4,500.00
Taylor $2,500.00

1. Prepare a checklist of all the tasks Mario will need to do to make sure the worksheet is
completed on time.
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2. Produce a worksheet with these details, then complete the following tasks:

o Calculate the 10 per cent interest charge and the customers’ new balances.Check the
data you entered against the customer information you have been given and correct
any errors.

o Create a 3-D column chart as an object in the worksheet that displays the
information visually.

o Name and store your worksheet in a suitable location.

o Select and print the data in your worksheet. Preview the data before printing and
make adjustments as necessary to format the data.

o Print the chart out as a separate page. Preview the chart before printing and make
adjustments to include a chart title.

o Exit Excel.

Part B

In this activity you will create a worksheet, accurately enter data, proofread the worksheet,
write formulas and check that they are correct. Find some data from your workplace,
previous employment or life experience that needs to be entered in a worksheet. Make sure
the worksheet requires a formula. Talk to your trainer or supervisor if you need to. Once
you have identified the data, try to complete the task in one hour. Follow these guidelines
when entering your data:

o Enter the data accurately and proofread your entries.

o Use formulas and functions to perform at least one calculation. Use a calculator to check
that your calculation is accurate.

o Askadvice from your manager to find out what you should name your worksheet and
where you should store it.

o Print out your worksheet and present it to your manager or trainer.

Part C

In this activity you will create a worksheet, accurately enter data, proofread the worksheet,
write formulas and check that they are correct. Try to complete this task in one hour.

« Look at the following ‘Sales results’ table. In a worksheet, enter the data exactly as it is in
the example.

o Calculate the monthly totals and enter them into the “Totals” boxes.
o Use a function to work out the ‘Overall total’.

o Check that all data and calculations you entered are correct. Remember to proofread the
spelling of the names.

o Name the worksheet ‘Sales results’ and store it in an appropriate place.

o Print out your worksheet to present it to your trainer.
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lSales results

‘Name January February March April
Andrew $2,333.00 $5,412.00 $3,456.00  $5,412.00
Belia $2,345.00 $6,712.00 $1,233.00 $5,000.00
lAnh $5,000.00  $6,000.00  $1,244.00  $3,000.00
jJacqui $2,345.00 $2,000.00 $2,355.00 $3,400.00
Dylan $6,000.00 $1,500.00 $1,200.00  $3,500.00
Imran $8,500.00 $2,345.00 $4,500.00 $12,300.00
Aisla $2,456.00 $1,200.00  $5,000.00  $1,200.00
Totals | | I | |

| Overall total |:|
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